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Chapter 1: Extensions Management

1.1Group Manager: See “Group” Menu on the left hand size menu. This page is used to
classifiy group of extension or users in the system. It will be useful to define priority and
billing term for any company or organization. By default, the group that has been created by
the system is called “Default”, and please remind that this group can not be deleted.

Group Manager
[ View ] [ Add Mew Group ]

Display 1- 3 From 3
[ GID Company Department Position Music on hold Edit
o Default Default Default Default &
r 1 poise eng test eng &
Page1: Delete | Cancel

If we want to add a new group, we select “Add New Group”, the following screen

will be shown:
Group Manager

[ View ] [ Add Mew Group ]
GID Company Department Position Music on hold
3 o~ | | Default - Add Group

Cancel

“Music on Hold” is the name of music group, which it will be played while calling

every extension in this group, and different group can be assigned with different music .
When we input all values, we can press “Add Group” button, then the system will show like

the following screen:

Group Manager
[ View ][ Add Mew Group ]

Display 1- 3 From 3
[~ GID Company Department Position Music on hold Edit
[ o Default Default Default Default &
= 1 poise eng test eng &
r 2 poise sale sale Default &
Pagel: Delete | Cancel |
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1.2 Add Extensions : See “Extensions > Add Extensions” Menu, this menu is used to
add extensions into the system. It will be classified to be two types:

1.Add Sip Extension: Adding one by one like 1001, 5002, 7065, ......
2.Add Multiple Sip: Adding 2 and more extensions in range like 1001-1020,
4010-4050, ..........

When we describe 2 types of adding, we can observe that all parameters look same
except first parameter, “Extension”.

Add SIP Extension

Phone Setting:

Group Name Default:Default:Default ~
Phone Number [—‘

Caller ID |

Password |

Phone Number : This blank is used to assign phone number like 1001,3001, 6441,.....

Caller ID: This value is used to assign caller name or number which this value will be shown
when we use this phone call to another phone in Plextel IP-PBX system. We can assign same
as phone number like “1001”, “5005”, or assign with name like “John”, “Jane”, or assign
both like “ John 1001”

Auto Provisioning: This menu is used to setup ip-phone by pass these parameters to specific
ip-phone without direct setup on that ip-phone.

Auto Provisioning:

ENABLE I |

Phone Type NONE v

Phone MAC Address [—'

Allow Firmware Upgrade [

Custom Command R

ENABLE: Click for Enable this function.
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Phone Type: Select model of ip-phone from list menu, SNOM 300, SNOM 320, SNOM 360,
SNOM370, SNOM820, SNOM821, SNOM870, Yealink SIP-T12P, Yealink SIP-T18P, Yealink SIP-
T20P, Yealink SIP-T22P, Yealink SIP-T26P, and Yealink SIP-T28P

Phone MAC Address: Input MAC address of this ip-phone.

Allow Firmware Upgrade: If we would like to allow firmware upgrade automatically by the
system, we have to click here.



Custom Command: This blank is used to add some further command. ( only advanced user
or developer)All parameters left same as “Add Multiple Sip” like this example

Extension Manager

[ view Extensions ] [ Add SIP Extension ] [ Add Multiple SIP ] [ Add IAX Extension ] [ Add Analog Extension ] [View All,Add Follow-Me Extension]

Add SIP Extension
Phone Setting:

Extensions Range
Group Name
Password

Enable BLF
Codec

Video Codec
dtmf mode

Extension Monitor

Concurrent Call Support

Enable REINVITE
NAT Support

Support T.38 FAX
SIP Additional Setting

l through I
Default:Default:Default ~
l S
no v

Ve7iw Ve7i1a M esm [T 6729 [T 6.723.1 I iBC
I_Speex I_Ipclo radpcm

" 6726

[TH261 [ H.283 [T H.283p [ H.264

fc2833 ~

yes v

e

default ~

defautt ~

default ~

Dial Option:
¥ Allow calling user to Transfer (T)
V' Allow called user to Transfer (t)
[V allow calling user \"One Touch Record\" (W)
IV Allow called user \"One Touch Record\" w)
" Generatea ringing tone {r) " Provide Music on Hold (m)
Call Features:
Ring Timeout 30 v'
Pickup Call from Defauft:Default:Defautt
poise:eng:test
poise:sale:sale
Record Incoming Calls " Yes ™ No
Record Outgoing Calls T Yes @ No
Support Intercom [
Allow BARGE Call I
Default Language 'T-ﬁai. v
Allow Roaming Station Feature No
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Mailbox:

User Email Address : [
Enable Message Center User Login:  Yes v

Voice Mailbox :
Enable Voicemail Box : Enabled ~
Send Voice Message To Email : " Yes ' No

Voice Mailbox Description : [

Voicemail Password (fix) : |

Voice Mailbox Size (messages) : |
Fax Mailbox

Enable Fax Mailbox : No

Send Fax Message Notification To Email : Yes v
Attached Fax File To Notification Email : Yes v

Send Voicemail Notification For Incoming Fax : Yes v
Fax Mailbox Size : 20 v
Contact Information

Picture :

Business Phone :
Home Phone™ :

Business Fax :

Mobile :

Address :

Note :

APPLY

Browse... I

| Cancel |

Extension range: This value is used to add extension number in range, sequencially, like
1001-1009, 2001-2099.

Group Name: This value is used to assign group name, which assigned group is shown here
has been assigned from “ Group Manager Menu”. We can use a mouse click on drop down
list then all assigned group will be shown like this example

Group Mame Default:Default:Default | =
Password Default:Default: Default
poise:eng:test
poise:sale:sale

Enable BLF

By automatically, if we don’t select any group, the system will assign to be default group
like “ Default: Default: Default” . If we would like to assign other group, we can click mouse
on that specific group.
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Password: This value is used to assign ip-phone password, which this password is used to
verify when ip-phone make registration to the system.

Enable BLF: Click for enable “Busy Lamp Field”, which this function will be available as shown
in list menu like SNOM 300, SNOM 320, SNOM 360, SNOM370, SNOM820, SNOM821,
SNOM870, Yealink SIP-T12P, Yealink SIP-T18P, Yealink SIP-T20P, Yealink SIP-T22P, Yealink
SIP-T26P, and Yealink SIP-T28P. This function is used to monitoring status of another phone,
if monitored phone show busy status, we can see red light at the button which we assign to
monitor.

Codec: This menu allow us to select codec type, if we don’t select anyone, the system will

assign to be G711u and G711a, default codec used in sip protocol.

Video Codec: This menu allow us to select video codec, but anyway we should select this by
reference from video phone type.

DTMF Mode: This value is the frequency used on this ip-phone panel, by default, in Thailand
we use RFC2833.

Extension Monitor: If we select “yes”, we can monitor ip-phone ‘s registry status at menu
Status -> Phone monitor like this example.

Mo Number HName (Callerid) IPaddress Matsupport VideoSupport Status Type
1 192.168.0.124 192.168.0.214 L7 . L . Unmonitored ~ SIP
24000 @ @  Unmonitored  SIP
3 sipshe_wwwww .ncu .nn _ SIP
4 trunk®:Yasip Y hasdft 0.0.83.97 gves .,—,.3 Unmonitored  SIP
5 3004 3004 ®: ®., NS s
6 3003 3003 o ®. KW s
7 3002 3002 @ ®n P
g 3001 3001 192.168.0.190 @ @ IP
9 3000 3000 9. @ 1P

The green bar show 3001 is registered.

Concurrent Call Support: This value is number of lines that we allow to call this phone in
same time.

Enable REINVITE: If we select “yes”, ip-phone can communicate each other without server,
which it can reduce server load, but however we can not send signal like transferring

anymore.

Nat Support: This value will be set as “yes” when this phone register from different network.



Support T.38 Fax: This value will be set as “yes” when we set this extension to work with
T.38 fax system.

Sip Additional Setting: This value is reserved for advanced user or developer who want to
add more qualification to this extension.

Dial Option: This value is used to set option related with dialing like line transfer, ringing
option, and if we don’t select this, the system will set as proper default value.

Ring Timeout : Time in second unit that we assign this phone ring when there is incoming
line, when timeout the system will perform assigned fuction like voicemail or follow me,
depends on our setting.

Pickup Call From: List menu here is all assigned group name. we can select group if we want
to allow call pickup all phones in that group from this extension. Anyway this menu allow us
to select more than one group.

Default; Default; Default
Poise;IT:Programmer
Paoise: [T :Engineer

Pickup Call Fram

Record Incoming Call: If we select “yes”, the system will record all conversation when there
is incoming line to this phone. To see recorded file, go to menu Sound ->Call Record File

Record Outgoing Call: If we select “yes”, the system will record all conversation when there
is outgoing line from this phone. To see recorded file, go to menu Sound - Call Record File

Default Language: Select the default language, which it will be displayed in voicemail,
conference and any provided system.

Allow Roaming Station Feature: Select “yes” to allow registration from other phone. (To use
this feature please see menu “Key Features”.

Support Intercom: Intercom is the two way communication between 2 ip-phone by press
only one programmed button, so only listed ip-phone here can use this function.

Mailbox: If select “ Enable” , this phone will have own voice mailbox.



Mailbox:

User Ermail Address |
Enable Message Center User

Login : _ ==l
Voice Mailboox :

Enable Voicernail Box : Enabled -
Send Voice Message To Email : " Yes ™ No

Yoice Mailbox Description : |

Voicernail Password (fix) : |
Voice Maibox Size (messages) @

User Email Address: Input email address for this user to link with Plextel ‘s message center
system.

Enable Message Center User: Click here to allow this extension (user) has it own personal
message center.

Enable Voicemail Box: Click here to enable personal voicemail box.

Send Voice Message to Email: If select “yes”, mean assign system to forward voicemail
message to specific mailbox.

Voice Mailbox Description: Input the description of this voicemailbox.

Voicemail Password(fix): Input password to access this mailbox.

Voice Mailbox Size (Messages): Input number of mailbox.

Contact Information: Input information for this user.



Contact Information

Browse...

Picture :

Business Phone :

Business Fax :

|
|
Home Phone® : |
|
|

Mobile :

Address :

Mote :

IAX abbreviate from Inter-Asterisk eXchange, which has been developed for used in
asterisk system only, and can not communicate with other techlogy except devices which
have been designed to work with IAX. The main purpose of this protocol is elimination of
NAT problem founded in SIP protocol.

Normally, when we implement IP-PBX in organization, security issue is the most
important issue to concentrate, so every device have to pass firewall. When we use ip-phone
with sip protocol we always see “Register Fail” message, that means sip ip-phone can not
work properly with some firewall, even the admin said every ports have been opened. To
avoid this probem, asterisk developer has designed IAX protocol, which run on only one port,
4569, and can save 50% of bandwidth, if compare with sip.

To add IAX extension, go to menu Extensions - Add IAX Extension , the following
screen will be shown.



Extension Manager

[ View Extensions X ] [ Add SIP Extension X ] [ Add Multiple SIP X ] [ Add IAX Extension X ] [ Add Analog Extension X ] [View All X,Add Follow-Me Extension X]

Add IAX Extension

Phone Setting :

Group Name Default:Default:Default ~

Phone Number l—

Caller ID |

Password I_

Enable BLF no -

Phone IP-Address dy;amlc—v

Codec V671w Me711a IMesm I 6.729 I 6.723.1
[T iBc I speex I Ipcto I adpem I™ G.726

Video Codec [T H.261 I H263 1 H.263p [ H.264

Phone Monitor yes v

IAX Additional Setting

Dial Option :

IV Allow calling user to Transfer (T) X

¥ Allow called user to Transfer (t) X

[V Allow calling user \"One Touch Record\" (W) X

IV Allow called user \"One Touch Record\" (w) X

" Generate a ringing tone {r) X * Provide Music on Hold (m) X
Call Features :

Ring Timeout 30 v

Pickup Call from Default:Default:Default
poise:eng:test
poise:sale:sale

Record Incoming Calls  Yes @ No

Record Outgoing Calls  Yes @ No

Default Language Thai v

Allow Roaming Station

Feature NG >

Mailbox :

User Email Address  : |

Enable Message Center User Login 7Y o <

Voice Mailbox :

Enable Voicemail Box : Enabled ~

Send Voice Message To Email C Yes @ No

Voice Mailbox Description |

Voicemail Password (fix) : |
Voice Mailbox Size (messages) : I

Fax Mailbox

Enable Fax Mailbox : No v

Send Fax Message Notification To Email  : ?;siv
Attached Fax File To Notification Email : Yes v
Send Voicemail Notification For Incoming Fax  : Yes v

Fax Mailbox Size : ﬁ

w - ‘ Chapter:



Contact Information X

Picture X :

Business Phone X :

Home Phone X*:

Business Fax X :

Mobile X :

Address X :

Note X :

apry | cancel |

The previous screen present every parameters look like “Add Sip Extension”, actuallly
everything same, different only its protocol. When we complete adding, press Add Ext, then
the following screen will be shown:

Extension Manager
[ View Extensions ] [ Add SIP Extension ] [ Add Multiple SIP ] [ Add IAX Extension ] [ Add Analog Extension ] [View All,Add Follow-Me Extension]

Di;ﬂlﬂav' 1- 21 From 21 Extension Import l— Browse... Data Import | Extension Export |
-
[~ Humber TypeGroup pickup CallFrom  BLFI/RO/RINTLangAP PT":D": DIDFollowmeRoaming  UserEmail  vmail "2X dit
- %Eggs:am sip  Default:Default:Default ¥  « x Thai x none - » nicrora@hotmail.com " - ﬁ
[~ 1001:twosip Default:Default:Default ¢ « « % Thai + snom3s0 - % v v &
[~ 1002: sip Defsult:Default:Default ¥« « % Tha x none - « v v 2
r EES sip Default:Default:Default ¥ ¥  x Tha x none - “ v v &
[~ 1004: sip Defsult:Default:Default ¥« « | x Tha x none - « v - g
- iEEg sip  Default:Default:DefaultDefault:Default: Default x |of | o | % |Thai |x | none - » v v @
[~ 1006: sip Default:Default:Default ¥ o ¥ x Tha x none - X v - g2
- EEE sip  Default:Default:DefaultDefault:Default: Default % o « % Thai x none - « v v’ £
~ }ggg: sip  Default:Default:Default v F ¥ x Tha x none - « v - 2
r }ggg: sip  Default:Default:Default ¥ o o x Thai  yeslinktzs - « v v &
~ igig: sip  Default:Default:Default X ¥ Thai o yesinkt2s - “ v - 2
r mg: sip  Default:Default:Default X ¥  x Thai o yedinktz2 v X v - 2
r Hﬁ sip  Default:Default:Default X o o x Tha o yealinktz - " v - 4_2
[~ 2000:Mr. jax  Default:Default:DefaultDefault:Default:Default - v - é
TTwo ¥ ¥ ¥ x Thai x none %
Thoudsand
r gggg sip  poiseieng:test g;zﬁ;g?@it:mhu't ¥ o o  Thai o yeainktis - . v v é
- ggg} sip  poise:eng:test Enozif:;l!:;[;?tf::tlt:Default v ¥ Thai x| none - « v v e
r ggg% sip  poiseieng:test g;iiﬁ;g?g:lt:mhu't % o Thai % none - X v v ‘2
- gggg sip  poise:eng:test E);f;L:lEI:j[;?E:Lt:Dehult S ¥ Thai % none - " v v g
r itlﬁj b poise:eng:test E:fiLllll:l:Z?E:llt:Default o o o | Thai none - v v 4_2
I gggg: (iax) Default:Default:Default x| x| x I Thai | - . v - 2

This example we can see that Ext 6000 present as iax protol.
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1.4 Add Analog Extension

Analog Extension is a type of extension that using analog phone connect with analog

card (FXS port), whi

le analog card can be pci card or external device like channelbank.

To add analog extension, everything same as sip extension adding so we can go to
menu Extension - Add Analog Extension, the following screen will be shown:

Extension Manager

[ View Extensions ] [ Add SIP Extension ] [ Add Multiple SIP ] [ Add IAX Extension ] [ Add Analog Extension ] [View All ,Add Follow-Me Extension ]

Add DAHDI Extension

Phone Setting :

Group Name Default::Default::Default ~
Phone Number l—
DAHDI Port v

Caller ID [
Transmit Volume Gain 50—
Receive Volume Gain ﬁ

DAHDI Additional Setting

Dial Option :

Call Features :

¥ Allow calling user to Transfer (T) X

¥ Allow called user to Transfer (t) X

IV Allow calling user \"One Touch Record\" (W) X

¥ Allow called user \"One Touch Record\" w) X

" Generate a ringing tone (r) X * Provide Music on Hold (m) X

Ring Timeout
Pickup Call from

30 v
Default::Default::Default
poise::eng::test
poise::sale::sale

Record Incoming Calls No ~

Record Outgoing Calls No ~

enable callwaiting 7Yes v

enable callwaiting-callerid No +~

enable threewaycalling fqo v

Default Language Engllsh v

Allow Roaming Station Feature No v

Mailbox :

User Email Address [—
Enable Message Center user login  : Yes v

Voice Mailbox :

Enable Voicemail box : Disabled +

Send Voice Message to Email : No +«

Voice Mailbox Description |

Voicemail Password (fix) [—
Voice Mailbox Size(messages) [—
Fax Mailbox :

Enable Fax Mailbox : No ~

Send Fax Message Notification to Email : N07 v

Attached Fax file to Notification Email : No v

Send Voicemail Notification for incoming Fax  : No ~

Fax Mailbox Size : 720 y -

ol |—“ Chapter:



Contact Information

Picture :
Business Phone  :
Home Phone *:
Business Fax

Mobile :

Address :

Note :

APPLY Cancel

l—. Browse...

1.5 Add Follow-Me Extension

Follow-Me here means assign forwarding when some one call this number and no

response in specific time, we can assign automatically forward in this menu.

To set Follow-Me, go to menu Extensions = Add Follow-Me Extension, the
following screen will be shown:

Plextel System: @J
%

Show All | Close all
> Status

* Report

Group Manager

Fax
Call Control

> Call Features

> Sounds
Incoming Call
Outgoing Call
Schedules
VR
Site to Site Setup

* Manual Config

= Voice Interface
Log

> Advanced

Extension Manager

[ View Extensions ] [ Add SIP Extension ] [ Add Multiple SIP ] [ Add 1AX Extension ] [ Add Analog Extension ]

Me Extension]
Add Follow-Me Extension:

Extensions Number
Enable

Music On-Hold

First Level Number
Dial Timeout

Mumber

Second Level Number
Dial Timeout

Mumber

Third Level Number
Dial Timeout

Mumber

APPLY Cancel

Maone -

Yes -

Defaulc

1:| 2 3:
1:| 2 3
1:| 2 3

ifiew Al Add Follow-

There are three levels of forwarding, if First Level can not answer can not answer on

time (Dial Timeout), line will be forword to Second and Third level automatically.
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All parameters can be explaine as these following:

Extension Number: Input specific extension, which we have to select once from drop down

list.

Enable: If select “Yes”, enable this function, and “No” for disable.

Music On-Hold: Select Music On-Hold from list.

Dial Timeout: Unit of time in second, which the system will countdown, and perform next

level when time up.

Number: Three of destination number which they will ring all when assigned, or we can
assign one or two number.

An example of Follow-Me:

Extensions Mumber
Enable

Music On-Hold

First Level Number
Dial Timeout

Mumber

Second Level Number
Dial Timeout

Murnber

Third Level Number
Dial Timeout

Mumber

Cancel

sIP/1001 -

Yes -

Default -

15

1:[1002 2:[1003 3

15

1:[2001 712002 312003
15

1:30865121305 2

3

This example is shown followme of 1001, if 1001 does not answer in 15 s, call will be
forwarded to 1002 and 1003 (First level), if 1002 and 1003 do not answer in 15 s, call will be
forwarded to 2001,2002,2003 (second level), then third level. In this example, at third level,
destination number is mobile phone number with prefix “9”, because we have to apply
acceptable rule of the existing system.

When we finish, press “Save” and the following screen will be shown:



Extension Manager
[ View Extensions ] [ Add 5IP Extension ] [ Add Multiple SIP ] [ Add IAX Extension ] [ Add Analog Extension d Followe-

Me Extension]

Follow-Me Extension:
[ Number Enable List Number Edit
[~ 1001 yes Level1—> 1002,1003, és_’
Level2—> 2001,2002,2003
Level3—> 90866121905,,
Page 1: Delete Selected |

If we would like to see what extension have been set follow-me, we can see at

menu Extensions = View All
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Chapter 2: External Line Configuration

2.1Voice Interface Hardware

This menu is the most important part of the system and it should be setup at begining
because this part is the interface part between IP-PBX and PSTN.

PSTN channels can be classified into 2 types, as following:

1. Analog Channel : The telephony line inform of copper line with RJ11
connector. There are 2 types of modules :
1.1 FXO Interface: Connect with PSTN line.

In term of PCl analog telephony card, there are many types which have been
classified by number of ports (FXS or FXO) used.

12 Ports Card

2. Digital Channel: Digital telephone system which in Thailand the popular one is
called ISDN PRI or E1, and there are 30 channnels, concurrent call, per 1 line.

Due to IP-PBX system, to implement E1 system, we need E1 card, which one card
can be reached 4 E1 line, depends on requirement.

O - ‘ Chapter: Chapter 2: External Line Configuration



e
b

o - 4 E1 Channels
z 1 E1 Channel 2 E1 Channels

Next, to configure card, go to menu Voice interface —>Voice Interface
Hardware, then we press on “Detect Hardware”, the system will show detected card which is
put in pci slot on this moment.

Ploxtel Svsterm: @ Voice Interface Hardware
y . [ Current Interface d\ranced Settings ]

Shaw All | Close Al . Active: Status:

Sy —— Group Number: [1] ves oK
Device Type : Location :

e Interface Type : analog

Group Manager

- EEEEE

Call Control
ontro I selectal

* Call Features Echo Cancellation Technigue

* Sounds mg2 - Save Value
Incoming Call
S appLy | cancel

Qutgoing Call

Schedules

VR

Site to Site Setup
* Manual Config

=" Voice Interface

oice Interface
Hardware

PSTN Trunk Setting
SIP Trunk Setting
Maobigate

Gateway

This previous picture show analog card with 4 FXO and 1 FXS module, then we press “Apply”
and the system will show yellow bar at the top screen with wording “Click here to Restart IP-
PBX”, click it again.
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Group Number : [1] Active : yes Status : RED
Device Type : Astribank: Unit 0 Subunit 0: E1 Location : usb-0000:00: 1d.7-8
Interface Type : digital £1

Interface Range : to

Clock/Sync Source :
use incoming SYMC as primary sync source -

Cable Length: 0 db (C5U) / 0-133 feet (DSX-1) -

Frame Type: CCS -
Line Decoding: HDOB3 ~  CRC: Yes -

Echo Cancellation Technigue: mg2 ~

Save Value

aprLy | cancel |

This previous show digital channel type and device is asteriskbank, external channel
bank with USB interface. Next, select “use incoming SYNC as primary source", click APPLY,
the system will show yellow bar at the top screen with wording “Click here to Restart IP-
PBX”, click it again.

** If your using card is Sangoma, you have to set it first at menu Advaced Setting and

select Sangoma as following example.

Voice Interface Hardwars
[ Current Interface ] [ Detect Haru:lwar
Advanced Setting

Interface Type

Dial-Tone

APPLY I Cancel
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2.2 PSTN trunk Setting
Next, go to menu Voice Interface >PSTN Trunk Setting, and choose Add
Analog Trunk, the following screen will be shown

Dahdi Interface Setting
Interface Type analog

1) Interface Setup Description [test

Channel Number 1 = - 4 -

Channel Group Mone -

Trunk Name trunk:dahditest
Record Incoming Calls © Yes © Mo
Record Qutgoing Cals © Yes @ No

Default Language th -
Usage Type Wizard Voice (FX0) -

Channel TYPE FXO ~

Echo Cancel yes -

Echo Cancel on Pure TDM Yyes -
Echo Training ne -

Relax DTMF yes -

TX Gain |0.0

RX Gain [0.0

Busydetect yes -

Busycount I3

Country-Tone Yes ¥ Country Code [TH
Pulse Line no |~|

Caller ID Num |

Caller 1D Name |

Immediate(FXs only} © Yes * Mo
Additional Setting

Available Options:
hanguponpolarityswitch=yes/no
answeronpolarityswitch=yes/no
busypattern=500,500

usecallerid=no(as answer call immediately)

appLy | cancel |

Some parameter has been set as default, no need to change it, we will focus on
these following:

Channel Number: This value we have to assign related with “Define Raw Interface Card), if
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It has 1-4 channel as FXO, we have to input 1-4.

Trunk Name: Input name of this trunk.

Record Incoming Call: If we would line to record all incoming line, select “yes”, and we can
see recorded file at menu Soun - Call Recording File.

Record Outgoing Call: : If we would line to record all outgoing line, select “yes”, and we can
see recorded file at menu Soun - Call Recording File.

Channel Type: Choose FXO or FXS
When complete all values, press “Add”, the following screen will be shown

PSTN Trunk Setting

[ View Trunk ] [ Add Digital Trunk ] [ Add Analog Trunk ] [ Advanced Setting ]

[ Trunk Name Description Interface Type Channel
[~ trunk:dahdi:test test analog 1-4
Page 1 : Delete Selected |

Go to menu Voice Interface - PSTN Trunk Setting - Add Digital Trunk

R &
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PSTN Trunk Setting
[ View Trunk ] [ Add Digital Trunk ] [ Add Analog Trunk ] [ Advanced Setting ]
Dahdi Interface Setting

Interface Type digital

1) Interface Setup ChannelMumber 1+ - 1 =
Channel Group Mone -
TrunkName|
Descriptinn|

PRI switch type euroisdn

PRI reset interval {ms) |

FRI Dialplan unknown -

PRI Local Dialplan unknown -
International Prefix bﬂ

Mational Prefix 0

Local Prefix |

Private Prefix |

Unknown Prefix |

pDID Yes -

Calingpres Yes -

Relax DTMF Yes -

Clock © Master ™ Slave

Echo Cancel Yes -

Echo Cancel on Pure TDM Yes -
TX Gain 0.0

R Gain 0.0

Record Incoming Calls € ves ™ o
Record Outgaing Calls © Yes ™ Mo

Default Language th -
Caller ID Mum |

Caller ID Name |
Additional Setting

appLy | cancel |

We have to assign these following:

- Channel Number: Assign this related with detected hardware, like sample, start
from 1-15, 16 for D channel (signaling), and 17-31.

- Trunk Name:Input name of this trunk.

- Clock: If we generate clock, select “Master”, otherwise select “Slave”.

To perform this menu completely we have to add 1-15 as beginning, then click
“APPLY” , and select “Add Digital Trunk” again to add channel 17-31, like this
example.
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PSTN Trunk Setting

[ View Trunk ] [ Add Digital Trunk ] [ Add Analog Trunk ] [ Advanced Setting ]

Dahdi Interface Setting

Interface Type

1) Interface Setup

digital

Channel Nurmber 17 » - 31 -

Channel Group Mone -
Trunk Mame trunk:dahdi:Trunk_E1 -

apeLy | cancel |

When adding complete, the following screen will be shown.

PSTN Trunk Setting

[ View Trunk ] [ Add Digital Trunk ] [ Add Analog Trunk ] [ Advanced Setting ]

Page 1

[ Trunk Hame

-

[~ trunk:dahdi:Trunk_E1

Delete Selected

Description

Interface Type Channel
digital

1-15
17-31

R E

§

This table present configured value assigned from service provider in Thailand.

PRI Dialplan | PRI Local Dialplan | International Prefix | National Prefix | Relax DTMF
TOT unknown unknown 00 0 Yes
True unknown unknown 00 0 Yes

Next , Go to menu Outgoing Call > Add New Outgoing Call.
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OutGoing Call
[ View Cutgoing ] [ Add New Out Going Call ]
DOutgoing Route Information

Route Mame [

Route Description |

Route Password |

Time Based Call Routing

Default Route

Add | M Enable Trunk: ZAP/trunk:dahdi:test = pefault Qutgoing Number: |

Prefix: Digit: to Strip: Dialing Option: |T

Dialing

First Schedule
Enable Schedule I Yes ® MNo

Time ftime -

Add | Trunk: ZAPftrunk:dahditest ~ pefault Qutgoing Number: |

Prefix: Digit to Strip: Dialing Option:  |T

Dialing

Second Schedule
Enable Schedule © Yes ® MNo

Time time d

add| Trunk: ZAPftrunk:dahdi:test + Default Dutgoing Number: |

Pref:: Digit to Strip: Dialing Option: |T

Call Patterns

Dialing

Call Prefix

—
Destination Pattern |
Destination Pattern2(optional) |
Destination Pattern3(optional) |

Dial Timeout b0
Concurrent Call Limit for this trunk 100
Strict Time Routing No -
Support DID With This Route No =

APPLY

Outgoing Route Information:

Route Name:Input name for this routing here.

Route Password: If we assign password here, everytime when dial out, the system will ask

this password for authentication.

Route Description: Input description to make the other understand.
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This feature means call routing that related with scheduling. This feature will be
applied if we use gsm gateway like a trunk, while we can program call routing prioriy to
match with service provider ‘s promotion, like if we have call free promotion for 8 am to 5
pm, we can program that this trunk will be first priority to save cost of the company.

In the beginning, we have to assign “Default Route”, in this terms mean assign
available trunk that will be applied when other trunks can not used.

Add: Select trunk then click this button.

Trunk: In this drop down menu show all defined trunk in the system, we have to select
sequencially.

Default Outgoing Number: This value is used only in E1 system, to specific outgoing callerid
as default, if any extension has no own out going caller id, the system will apply this value.

Dialing Prefix: Call prefix which this number will not be actually sent out.
Digit to strip: Number of digit to strip that related with prefix

Example of create “Default Route” after press “Add”.

Default Route
Enable No. Trunk / Group Default Outgoing Number Dialing Prefix  Digit to Strip dialing_option
W 1 trunk%%dahdi%d%test T B8

@dd| ¥ Enable Trunk: ZAPftrunk:dahdiitest ~ Dpefault Outgoing Number: Dialing Prefic
Digit to Strip: Digling Option: |T

All values here same as default route, these following have been added

Enable Schedule: Select “yes” to apply this schedule.

Time: Click at drop down list, created schedule will be shown, if there is no created schedule,
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we have to create at menu “Schedule”(Topic 4.1 in this manual).
If there is some created schedule, the screen will appear like this example/.



First Schedule
Enable Schedule ™ Yes © MNo

Time  fime -
time

_Add | wwewwnnw :dahdi:te:
| —

Other parts we input same as Default route, and the next example is the sample

screen when press “Add”.

First Schedule

Enable Schedule ™ Yas © Mo

Time business_time -

Enable Mo. Trunk [ Group Default Outgoing Number Dialing Prefix  Digit to Strip dialing_option

VW 1  trunk%%dahdi%%test T B8

Dialing Prefi:: Digit to

Strip: Diling Option: |T

Call Pattern: The following picture present call pattern setting which some value shown here
is the default value.

Call Patterns

Call Prefix [

Destination Pattern ’—
Destination Pattern2(optional) l—
Destination Pattern3{optional) l—
Dial Timeout ko

Concurrent Call Limit for this trunk W

Strict Time Routing No

Support DID With This Route No -

Call Prefix: Define prefix of this outgoing rule. Example like press 9 to call PSTN, press 8 to
call international.

Destination Pattern: Define destination pattern.

Destination Pattern2: Second destination pattern.

Destination Pattern3: Third destination pattern.

Dial Timeout: Unit of time in second, if timeout, system will be terminated.

Concurrent Call Limit for this trunk: Define allow maximum concurrent call for this trunk.
Strict Time Routing: If select “yes”, means there are setting First schedule and Second
Schedule.

Support DID with this route: Select “yes” if this trunk need DID to call out. (E1 only)
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Example of create Outgoing Call

OutGoing Call
[ View Outgoing ] [ Add New Out Going Call ]
Outgoing Route Information

Route Mame |pstn

Route Description [

Route Password |

Time Based Call Routing

Default Route
Enable No. Trunk / Group Default Outgoing Number Dialing Prefix  Digit to Strip dialing_option
v 1 trunk®:%dahdi%e%test T

add| ™ Enable Trunk: ZAPftrunk:dahdiitest = Default Outgoing Number: Dialing Prefix:
Digit to Strip: Dialing Option: |T

First Schedule
Enable Schedule " Yes & No

Time time -
Enable No. Trunk / Group Default Outgoing Number Dialing Prefix Digit to Strip dialing_option

Add| Trunk: ZAPftrunk:dahdi:test + Default Qutgoing Number: Dialing Prefi: Digit to
Strip: Dialing Option: [T

Second Schedule
Enable Schedule T Yes & No

Time ffddfd -
Enable Mo. Trunk [/ Group Default Outgoing Number Dialing Prefix Digit to Strip dialing_option

Add| Trunk: ZAPftrunk:dahdi:test = Default Outgoing Mumber: Dialing Prefix: Digit to
Strip: Dialing Option: |T

Call Patterns

Call Prefix

Destination Pattern

1x
Destination Pattern2(optional)

ﬁD

1

Destination Pattern3(optional)

Dial Timeout

Concurrent Call Limit for this trunk oo
Strict Time Routing no -
Support DID With This Route no -

APPLY
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Go to menu Voice Interface -> Sip Trunk Setting, this menu is
used for configure sip trunk like voip service provider, while we have to apply for any
account from any service provider, and bring given information to apply here, like
Username, Password, IP-Address (or domain name).

SIP Trunk Setting
[ View Trunk ] [ Add SIP Trunk ]
SIP Trunk Setting

Trunk Mame |

Description |

Type SIP Account -

Sip Server Address|
Tel MumberfUsername I—
Password |

Allow Incomming Yes ~

Concurrent Call Support |1
Optional: Number of digit to strip |

Optional: Dialing Prefix

Record Incoming Calls ¢ Yes ® MNo
Record Outgoing Calls © Yes ™ No

Default Language th =~
Advanced Setting No 7

appLY | cancel |

All parameter can be explained like these following
Trunk Name: Define trunk name here.
Description: Input descripton of this trunk
Type: 2 type of provider.
1.Sip Account: Given Username, Password
2.Sip Trunk: Username and password is no need.
Sip Server Address: Input IP-Address or domain name.

Tel Number/Username: Input given Tel Number/Username from service provider.

Password: Input given password from service provider
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Allow Incoming: If select “yes”, it means allow incoming call for this trunk, but normally
service provider in Thailand will not allow incoming call except Cat 2 Call Plus, CAT telecom,s
service.

Concurrent Call Support: Number of concurrent call for this trunk, normally 1 concurrent / 1
account.

Optional Number of digit to strip: Number of digit to strip related with each service
provider.

Optional Dialing Prefix: Prefix number related with each service provider.

Record Incoming Call: If select “yes”, all incoming line will be recorded, and we can check
recorded file at menu Sound = Call Record Files.

Record Outgoing Call: If select “yes”, all outgoing line will be recorded, and we can check
recorded file at menu Sound = Call Record Files

Default Language: Input default language for this trunk

When we complete all values, click Save, then we have to create Outgoing Call and
also set call control same as we have done in PSTN setting.

Integration This part is GSM gateway setting, we will separate into 2
parts:
- PLEXTEL-EE part
- GSM-SIP-Gateway part

(PLEXTEL-EE part)
PART 1: Gateway Setting

Go to menu Voice Interface > Gateway

Gateway

[ View Gateway ] [ Add Gateway ]

Display 1-1 from 1 20 -

[ Mame Mumber IP-Addresss Extension Monitor Record IN Record OUT Edit
[ test sys 4000 Dynamic Mo M M é

Page 1: Delete Selected Cancel
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In this menu, we will create extension for gateway to register with Plextel.

Gateway
[ View Gateway ] [ Add Gateway ]

Mame |

Mumber | Account |

Default Language English

Password Ii

IP-Address dynamic -

Codec v G.711u v G.711a [ Gsm | G720 [ G.723.1
[ itBC ' Speex I Ipcio [ adpem | G.726

dtmf mode rfc7833 -

Extension Monitor no -

Concurrent Call Support lli

Enable REINVITE default -

MAT Support default -

CallerlD Number |
CallerlD Name |
Record Incoming Calls " Yes ™ MNo
Record Qutgoing Calls " ag ™ No

appLy | cancel |

Name: Input trunk name related with Plextel.

Number/Account: Input a Number or Account with can not same as defined extension

in Plextel.

Default Language: Input default language for this trunk.

Password: Define password which gateway have to use this password to register.
IP-Address: Input IP-Address of gateway, normally we set to be “dynamic”.

Codec: Define codec type.

dtmf mode: Define dtmf mode used for this gateway.

NV W

Concurrent Call support: Input maximum call support, which depends on number of
ports of this gateway. Example: we use gateway with 4 FXO, so this value will be 4.
9 Enable Reinvite: Define packet type to be Reinvite.

10 NAT Support: If this device is working behide NAT, we have to set NAT=yes.

11 CallerID: Set caller id to be default value.
12 Record Incoming Calls: Allow recording incoming call.
13 Record Outgoing Calls: Allow recording outgoing call.
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This part is setting incoming call for gateway, everything same as setting PSTN, but for
gateway setting we have to input DID as the following example.

Incoming Call
[ View Incoming Call ] [ Add New Incoming Call ]

Display 1- 5 from 5
[ Trunk Destination DID Description Edit
| gateway:sip:test sys 0 time T 111 202 ;jf_’

This example show setting gateway account as no.201 and trunk name is “test”.

Incoming Call
[ View Incoming Call ] [ Add Mew Incoming Call ]
Add Incoming Call

Trunk gateway:sip:test_ sys * [ pABX-ink
Description |

Support DID yes -

Incoming DID 202

Replace CallerID |

Extensions Ring Timeout{sec) 40 -

Add time based handler |

Actions
When * | {jmea ~ Destination™ | psp -
value 111 hd
Remove

appLy | cancel |

We have to set Support DID = yes and Incoming DID should not same with account of
gateway like 202, while 202 will be set in gateway to send incoming call from gateway to
PLEXTEL.

Go to menu OutGoing Call
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OutGoing Call
[ Wiew Qutgoing ] [ Add Mew Out Going Call ]

Display 1 - 1 from 1

I Route Hame Descriptions Call Prefix Call Pattern Schedule Enable Edit
[~ gateway 200K Default Default &
First / time no
Second / time no

Page 1 :

Delete Selected |
We have to add gateway as trunk, then we call out from this gateway.

Time Based Call Routing

Default Route

Mo. Trunk / Group Default Dutgoing Number  Dialing Prefix  Digit to Strip Delete
1 gateway ¥ %hsip%hctest Dell

Add | Trunk: Igatean:SiD!tESt ;I Default Cutgaoing Mumber: I Dialing Prefix: I Digit ko Strip: I

(GSM-SIP-Gateway part)
PART 1: SIP Setting

] . . .
Service Domain Settings

Route ‘ IMnbiIe1 'I
Mobile ‘ Realm 1 (Default)
Network ‘ Active: & o OFF
SIP Settings ‘ Digplay Mame: |2I31
: = User Mame: |2D1
\CDdEI: Setting; Register Marme: |2I31
Codec ID Settmg Register Passward: |.u.u
OTMF Setting
RPaort Setting Domain Server: |192.1EB.D.MD
SIP? Responses Praxy Sewver [152 168 0140
Other Settings

MNAT Transferm

Update

[192.168.0.140
Status: Registered

Cuthound Proxy:

Go to menu “SIP Setting = Service Domain” , and see previous example which it is
setting SIP Account for SIP Gateway. Anyway all values here have to match with we have

set in PARTL.
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Each value can be explained like these following:

Display Name/ User Name/ Register Name: Input Account no. which we have set in
PLEXTEL.

Password: Input password which we have set in PLEXTEL.

Domain Server/ Proxy Server/ Outbound Proxy : Input PLEXTEL ‘s IP-Address.

When finish all, we have to SAVE and REBOOT everytime.
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LAN To Mobile Table

If‘u"ltlhile 1,2 "I
Page:|1 'I

[ ftem [ WAL | CallNum | Select
a 192.168.0.140 # r
1 ]
2 |
3 ]
1 r
5 ]
B |
7 ]
& |
g ]

Delete Selected Delete All | Reset |

Go to menu “Route -> LAN To Mobile Table”

Input thes following values:

Position =0

URL = “IP-Address of PLEXTEL IP-PBX”
Callnum =#
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Mobile To L AN Table

IMDbiIe 1,2 vl

Page: |1 ’I
[} * 202 | |
1 Ly -
= =
=} =
4 =
5 =
[} =
7 =
= =
g =

Delete Selected I Delete All I reset I

Add New

Position: I O~497

D I Ex:03911111111, O911*, *

URL: I Ex:192.163.0.1, =25t

Ao reset I

Go to menu Route -> Mobile to LAN

Input these following values:

Position =0

CID=*

URL= “Input number from PLEXTEL PART 2, like following screen”

Add Incoming Call
Trunk gateway:sip:test sys * [ paABX-ink

Description |

Support DID yes -
Incoming DID |2I]2
Replace CallerID |
Extensions Ring Timeout(sec) 40 -
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2.4.2 Setting Gateway to work with Soundwin
Create Gateway like previous part (GSM Gateway).

Gateway

[ View Gateway ] [ Add Gateway ]

Name 3000

MNumber [ Account 3000

Default Language

Password sess

IP-Address u

Codec 7 7 )
G.711u G.711a G5M G.729 G.723.1 iLBC

Speex —lpc10 “ adpem M G. 726

dtmf mode H
Extension Monitor
Concurrent Call Support 1

Enable REINVITE [defautt [+ ]
MNAT Support default [~ |
CallerID Mumber 3000

CallerID Mame 3000

Record Incoming Calls ves @ png
Record Outgoing Calls ves @ png

APPLY Cancel

Then we got like following example.

Gateway
[ View Gateway ] [ Add Gateway ]
Page
Name MNumber IP-Addresss Extension Monitor Record IN Record OUT Edit
3000 3000 Dynamic Mo M M é

Delete Selected Cancel

Then we log on Soundwin, and go to menu Advanced = VolP Basic, and make registration
with PLEXTEL ‘s assigned number like these following:

VolP Protocal Setting: Select protocol type as SIP.
No. : Imput port number.

Number: Input extension or gateway no.
Account: Input defined account number.
Password: Input defined password number.

SIP Proxy Setting: Input IP of SIP server like following example:
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VolP Protocol Setting |SIP [~

Port Number / Password Setting(MAX 25 digit) :

Number

Account

Password

13000

3000

Use Public Account (PORT 1)

[ © Enable @ Disable

SIP Hunting Table :

No. Hunting Member
1 Port 1 [ Port 2
2 1 Port 1 [7] Port 2

Domain/Realm

192.168.0.130

SIP Proxy Server

392.168.0.13&’5060

Use NetZPhone Service

Register Interval (seconds)

900

SIP Authentication

Outbound Proxy Server

| @ Enable [© Disable

| [192.168.0.130/5060

NAT Pass Setting:

NAT Pass Method © STUN @ Symmetric RTP
STUN Server IP Address 64.69.76.21
STUM Server port 3478
NAT IP Address 0.0.0.0
Local Setting:
Local SIP Port 5060
Apply

Click Apply, select Register and Apply again, then save configuration and reboot.
If register success, the screen will show like this example:

VolP Protocol Setting |SIP [~]

Port Number / Password Setting(MAX 25 digit) :

Mo. Number Reg Account Passwaord Register Status | Reason
1 || |3000 3000 Success OK
2 O

ion

igurat

ine Conf

External L
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Setting Hotline for mapping with DID in incoming call of PLEXTEL IP-PBX.

Hatline Delay @ Disable © Enable
Hotline Delay Time(Max. 20 sec) 3 SeC

Port 1 number 1111

Port 2 number Mone

In this example, defined number is 1111 which have to map with menu “Incoming
Call” in PLEXTEL, then we input DID to map with Hotline no. in Soundwin.
Incoming Call

[ view Incoming Call ] [ Add New Incoming Call ]

Add Incoming Call
Trunk [ gateway:sip:znon [+] [ pagx-ink
Description |
Support DID [yes[+]
Incoming DID |1111 |
Replace CallerID |
Extensions Ring Timeout{sec) [40][~]
Enable CallerID-Based Routing Service (Mo [+]
[ Add time based handler ]
[ Actions
|'I.|'Il'hen *”| Al Time =] ”Dstinatiun* [Group E||

|Va|ue [ Defaukt:Default:Default [« | |
= |

This example, we discuss on Trunk that receive incoming from “gateway:sip:3000”, have DID as 1111,
and perform assigned action.
In term of Outgoing, we create like normal outgoing, while we add trunk to be gateway trunk.
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This part we will discuss how to create trunking between 2 sites by gsing
PLEXTEL IP-PBX, while we can select protocol between IAX and SIP

Site to Site Setup 1 2
[ View Site ] [ Site to Site Setup ]ﬁmsite (5IF) ] t

1. IAX Site to Site
2. SIP Site to Site
This screen show site-to-site setup screen.

Site to Site Setup
[ view Site ] [ Site to Site Setup ] [ Site-to-Site (SIP)
Add IAX2 Trunk
Trunk Hame |
Remote IP Address Dynamic -
Remote Password
Local Password
¥ .71 |¥ G.711a [V Gsm W G729 V¥ G.723.1
Codec Used
¥ iLBC W Speex W lpcio ¥ adpem ¥ G728
Destination Patt Dialing Preﬁx:| Pattern:l
estination Pattern
Mumber of digit(s) to strip:
Destination Pattern2 (Optional) Dialing Prefis:| Pattern:|
estination Pattern iona
Mumber of digit(s) to strip:
Pestination Patterns (Optonal) Dialing Prefix:| Pattern:|
estination Pattern iona
Mumber of digit(s) to strip:
Destination Patternd (Optional) Dialing Prefix:| Pattern:|
estination Pattern iona
Mumber of digit(s) to strip:
o X Dialing Preﬁx:| Pattern:l
Destination Pattern5 (Optional)
Mumber of digit(s) to strip:

APPLY | Cancel

- Trunk Name: Input trunk name.

- Remote IP Address: Destination IP-Address, normally we use “Static”, and define its IP.
- Remote Password: Input password for remoted site.

- Local Password: Input password for registration from another site.

- Codec Used: Select codec type.

- Destination Pattern: Define call out destination pattern.

- Dialing Prefix: Input prefix no.

- Pattern: Input pattern.

- Number of digit(s) to strip: Input no. of digit to strip.
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When we have done both sites, the following screen will be shown.
Site to Site Setup

[ View Site ] [ Site to Site Setup ] [ Site-to-Site (SIP) ]

Display 1 - 1 from 1

Trunk Remote IP Destination
r MName Address Pattern Codec Edit
r test_site (1292, i?ét.lg.m[l} 1|2 I G.711a,G,711u,5peex, G5M,ILBC, G, 729,G. 723, 1,adpcm,lpc 10 £
Page 1

Delete Selected | Canoell

We can check registration status at menu “Phone Connection Status”.

Phone's Connection Status

SIP
No Number Mame (Callerid) IPaddress Natsupport VideoSupport Status Type
1 4000 -none- [ Dra Unmonitored  SIP
2 trunk®%sip%Seasdf 0.0.83.97 @ [ T Unmonitored ~ SIP
3 3004 3004 -none- no .no _ SIP
4 3003 3003 -none- [ . UNKNOWN  =iF
5 3002 3002 ~none- o e UNKNOWN =T
6 3001 3001 -none- .no .no _ SIP
7 3000 3000 -none- [ - UNKNOWN =77
8 1144 1144 -none- P . UNKNOWN =77
9 1114 1119 -none- no no _ SIP
10 1010 1010 -none- L. L . UNKNOWN  STF
11 1009 1009 192.168.0.190 L Dz OK(58ms) | =i
12 1008 1008 -none- .nn .no _ SIP
13 1007 1007 -none- D 9. UNKNOWN  5IF
14 1006 1006 -none- - @ UNKNOWN ~ =TF
15 1005 1005 -none- .nu .no _ SIP
16 1004 1004 192.168.0.184 Dy ®.. ok@imsg S
17 1003 1003 -none- no ho _ SIP
18 1002 1002 -none- [ . R -
19 1001 two -none- .no .ng _ sIP
20 1000 on Thouzand -none- .yes .no _ sIP
IAX
1 server_test_sit 192.168.0.100 {DOK{Ams) 1ax2
SO TS fUmSpeCie AX2
3 2000 Mr, TTwo Thoudsand (Unspecified) IRERER 122
4 FaxD5P2/FaxD3P2 127.0.0.1 SR 1ax2
5 FaxD5P1/FaxDsP1 127.0.0.1 SR 1ax2
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Chapter 3 System Features

3.1.Conference
Go to ment Call Features > Conference, the following screen will be shown

Conferences Manager
[ View Conferences ] [ Add Mew Conference Room ]

[ Conference Room Room Password Admin Password Record
[ 600 Mo
Pagel : Delete Selected Cancel

Select “Add new Conference”, the following screen will be shown

Leader
Mo

Edit

e
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Conferences Manager
[ View Conferences ] [ Add Mew Conference Roomn ]

Roomn Mumber |
Conference Password |
Conference Admin Password |

Custom Voice Greeting for this room Mone -
Enable User Based Conference Mo -
Record This Conference Room Mo -
Disable All Announcernent (MUTE ALL) No =
Disable Announcement For Single User In Room No -
Announce User Count when Join Conference Yes -
Announce User Join/Leave Mo -
Enable Voice Menu mode Yes -
Enable logoff from conference using # key Yes -
Enable MusicOnHold for Single User login Yes = Default -
Enable Monitor Mode (# prefix) Mo =
Enable Leader Mode Mo -
Conference Leader Dialing Mumber [
Close the conference when Leader exit Mo -
Run Custom Menu (1 digits) Mo -
appLY | cancel |

All parameter can be explaine as following:

- Room Number: Input room number

- Conference Password: Input password for this room.

- Conference Admin Password: Imput password for admin.

- Custom Voice Greeting for this room : Select greeting voice for this room.

- Enable User Based Conference: Define user and password for participant.

- Record this conference room: If select “yes”, all conversation will be recored, and we
can check recorded file at menu Sounds -> Call Record Files (conf).

- Disable all announcement (MUTE ALL): If select “yes”, all announcement will be closed.

- Disable Announcement for Single User in room: [f select “yes”, the system will close
announcement when first participant enter this room.

- Announce User Count when Join Conference: If select “yes”, system will announce
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number of participants for next entry person.
- Announce User Join/Leave: If select “WihtReview”, system will ask joinging participant ‘s
name and announce to the other.



“uxn

- Enable Voice Menu mode: If select “yes”, participant can press to listen and sel
menu.

- Enable logoff from conference using # key: If select “yes”, “#” button will be applied to
use for leaving out from this room.

- Enable MusicOnHold for Single User login: Enable Music on hold, when first participant
is waiting the other.

- Enable Monitor Mode (# prefix): If select “yes”, any user can listen conference room
without talking by press # and follow by conference room number.

- Enable Leader Mode: Click to enable leader mode.

- Conference Leader Dialing Number: Define number for leader to access this room.

- Close the conference when Leader exit: If select “yes”, this room will be terminated
when leader leave out.

- Run Custom Menu (1 digits) : This part for additional programming by developer only.

When we complete all value, click “Save”, click yellow bar at top menu to reload”,
then we will define permission of conference room by go to menu Call Control.

This following screen present accept permission of conference room for only
“Default” group.

Call Control
2 5
e b
Group Name # %ﬁ ﬂ g
Rk R 1] P T
w I = [E]= |+ & =
il s
52 g%%sgfﬁﬁnss
eSS HBIES 3L F 3
FEELLELLF I
FFFFFFFFH'!E'FI*IVW,
MMM (T Vi (|
qaaqg R O i |
wwwww(SIP) O o (i~
hello_world O o o ol ol ol A
testttt C|\C\Cc|\CiC({C\C\CeypeyC|\ce e e
test fax 72 2 2 o o
fascooooom I_I_IVI_I_I_I_I_I_I_I_I_I_I_I_.

Page 1: m

B Extensions Group Outgoing Call Call Features  Site-to-Site [ Queue  IWR  FAX
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Next, we can test conference by using ip-phone and press 600 (created room), the
system will ask password, if password has been defined, then the system will announce
number of participants now.

If we would like to make conference with any person in outside system, we can call
their mobile phone and transfer line to created room number, example like #1 600, while 600
IS created room.

To monitor conference room, go to menu Report = Conference Status, the following
screen will be shown.

Conference Status

1
Conference Room Status 600 ~ K

Information for conference room: 600 Mute HI(

Kick Users [ CallerID Channel Mute / Unmute 4 Status
1001/two <= SIP/1001-00000045 Mute k‘ (unmonitored)

~ 6 . — |
2 1005/1005%= SIP/1005-00000046 Mute (unmonitored)

This menu can be explained as following:

1. Select room that we want to monitor.

2. Mute All, when we want to mute all participant, this button status will change to red, and
it will be green when we click to unmute.

3. LOCK, press when we need to block other users to join this room.

4. Mute, press if we want to mute this person.

5. Kick, press when we need to take off this person from this roo,.

Chapter 3 System Features

6. Caller ID or name of each participant.



3.2. Feature Key / Call Parking
Go to menu Call Features > Feature Key & Call Parking, the following screen will be
shown:

Features Code [ System Setup

Call Center Code

Agent Login {permanent) * - E

Agent Callback Automatic = 4 }457
Login,Logoff

Agent CallBack Login S l"l_O

Agent CalBack Logoff *F - F&l

Pause Agent Prefix * - FZ

UnPause Agent Prefix * - FB

Transfer to Agent Prefix l‘ﬁ

Whisper * vz

Private Whisper * - EB

Channel Spy R l‘ﬁi Password:|1234
Call Parking

Parking Mumber lTUUi

Parking Position [701 -[720

Max Parking Time 120

Transfer digit timeout 3

Features Key Mapping

Features digit timeout(ms) 3000

Call Pickup =~k
Extensions Pickup * - I‘i
Blind Transfer # - lli
Attend Transfer # - lzi
Disconnect * - I]i
One Touch Recard = - |37
Voicemail Ir

Phone Lodk |‘3‘37
Roaming Station Register /Dial- o 'ﬂi
Out Prefix

Fax Prefix - |337
Features Key Mapping

CUSTOM1 * v | Enable

APPLY Cancel

Restore Default |

Call Parking: In this term, call parking means holding line from concurrent call for a while. In
Plextel IP-PBX we have to transfer this line to no0.700, and the system will automatically
announce our number of parking status like 701, 702 ...., if we want to pick up that line
again, we will dial to announced number like 701, 702, related with define parking position.
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Transfer Digit Time Out: Unit of time in second that allow users to press each digit for using

this feature.

Feature Digit Timeout: Unit of time in millisecond that allow user to press for access any

feature.

Call Pickup: In this term we can pick up incoming call by press *8, to pick up any extension

existing in same group.

Normally, we have to set permission for each extension at extension menu.

Plextel Svetem @J Extension Manager
Bxlel vystem. [ View Extensions ] [ Add SIP Extension | [ Add Multiple 5IP ] [ Add TAX Extension ] [ Add Analog Extension ] [View Al Add Follow-Me Extension]

Show All | Close All
* Status

¥ Report

Gmni Manager

Fax
Call Control
* Call Features
 Sounds
Incoming Call
Outgoing Call
Schedules
VR
Site to Site Setup
¥ Manual Config
¥ Voice Interface
Log
¥ Advanced

Display 1 - 30 From 30

20

Page 1

[~ Number TypeGroup

v

[~ 1000:0on sp
Thousand

[~ 1001: twosip

[~ 1002: sp
1002

[~ 1003: sp
1003

[~ 1004: sp
1004

[~ 1005: sp
1005

[~ 1006: sp
1006

[C 1007: sp
1007

[~ 1008: sp
1008

[~ 1008: sp
1005

[T 101: sp
1010

Default:Default:Default Varar
Default:Default: Default FANIVAY,
Default:Default:Default f F 7 x
Default: Default:Default i f 7 x
Default:Default:Default S x
Default:Default:Default Default: Default: Default

x o ¥ X
Default:Default:Default « /oL x
Default:Default:DefaultDefault: Default:Default

X o o ¥
Default:Default:Default v
Default: Default:Default v
Default:Default:Default f A

Pickup Call From  BLFI/RO/RINTLangAP

Thai x

Phone
Type

none

Thai ¢ snom360

Thai
Thai x

Thai x

Thai x

Thai

none

nong

nong

nong

none

none

none

Thai v yedlinkt23

v’ Thai v yealinkt26

Extension Import Erowse...‘ Data Import | Extension Expart

DIDFollowmeRoaming  User Email

nicrora@hotmall.com

=

Bl K K| OK % % K| % %

When clink “Edit”, we can check permission of this extension like this following example.

Call Features:

Ring Timeout
Pickup Call from

Record Incoming Calls
Record Qutgoing Calls
Support Intercom
Allow BARGE Call
Default Language

Allow Roaming Station Feature

Default:Default:Default
poise:endg:testl234

¢ ves " No
¢ yez [ No
-

-

Thai -
No -

This previous picture we can observe that there are many group name form pick up

group list, if we would like to select group, we can click mouse on that group.

Vmail

o it
- ¢
49
v ¢
Vi d
v ¢
v ¢
v ¢
¢
v ¢
¢
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This menu show how to set pickup call since we create extension.
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Extension Manager

[ View Extensions ] [ Add SIP Extension ] [ Add Multiple SIP ] [ Add IAX Extension ] [ Add Analog Extension ] [View All, Add Follow-

Me Extension]

Edit SIP Extension
Phone Setting:

Group Mame
Phone Mumber
Caller ID

Password
Enable BLF

Phone IP-Address
Codec

Video Codec
dimf mode
Extension Monitor

Concurrent Call Support

Enable REIMVITE
MAT Support

Support T.38 FAX
SIP Additional Setting

Dial Option:

Defaul:Default:Default -

TOUT

ftwe

LL Xl

¥&5 + manual BLF num

dynamic -

We7rwWeral csm[ G729

W c.723.11 ilec [ speex| Ipc1o|  adpom
[~ G726

I "H261 [ H2e3 [ Ha2s3p [ H264
fc2833 | =

YEes w

=

default -

default =
default -

Call Features:

v allow calling user to Transfer (T)

I allow called user to Transfer (t)

v Allow calling user \"One Touch Record'”™ (W)

¥ Allow called user YOne Touch Recordy” {w)

" Generate a ringing tone {r) ™ Provide Music on Hold {m)

Ring Timeout
Pickup Call from

Record Incoming Calls
Record Outgoing Calls
Support Intercom
Allow BARGE Call
Default Language

Allow Roaming Station Feature

30 |~

Default:Default:Default

poise:eng:test1 234

* yeg T No
* ves T No
-

r

Thai -
Mo -

This picture present this user can pick up only extension in same group.

- Extensions Pickup: Pickup Call by press specific destination number by pressing * * follow
by extension. Ex: ** 1002, **1003.
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Blind Transfer is a transfer when the person receiving a call transfers the caller to another person without telling the that
person anything about the caller or why they are calling. This is usually very frustrating to the caller as they have to
introduce themselves and explain why the are calling again. If the no person receive that transfer call, that call will be
sent back to the person receiving a call. We can press *1 to send blind transfer code before sending the call to destination
number.

Attend Transfer is a transfer when the person receiving a call transfers the caller to another person and telling the that
person anything about the caller or why they are calling before transfer to them. We can press *2 to send blind transfer
code before sending the call to destination number. If the persons whom you transfer to, receives a call, you can hang up.
But if they don’t, you can press * to pick that call back to have a conversation.

Disconnect when you want to cut your line off while having the conversation, you can press *0 during the conversation
time.

One Touch Record You can record voice of talker while you’re talking. You can press *3 to automatic recording and
you can bring that file to play later at menu Sounds -> Call record File

Voicemail you can set the number to go to listen your voicemail by press on your phone. The number is 100, when you
call 100, it asks your password before you listen your voicemail. Make sure that you’ve created mailbox already. You

can check it at Extension menu.

[” Number TypeGroup Pickup Call From BLFI/RO/RINTLang AP T::: DIDFollowme Roaming User Email Vmailm:mxfdit
I %ﬁggsﬂl sip  Default:Default:Default “  « x Thai x none - " nicrora@hotmail.com - d_Z
[~ 1001:twosip Default:Default:Default v  « x Thai  snom3s0 ¥ X v v Z
I iggg sip Default:Default:Default % ¥ o x Thai x none - . v v d_Z
r }ggg sip  Default:Default:Default v ¥ ¥ x Tha x nome - « v v (_Z
r 133: sip  Default:Default:Default S ¥  x Thai x none - “ v - Z
[ 1005: sip  Default:Default:Default Default: Default:Default X o o x Thai x none - “ v v Z

1005

As the above picture, number 1003 has set mailbox, you can listen your voicemail. But if the mailbox has not

set, you can edit or create the new one following this below example
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Mailboac

User Email Address : |
Enable Message Center User Login : Yas -

|Enal:|le Voicemail Box : Enabled -

Send Voice Message To Email @ { ¥eg [+ No

Voice Mailbox Description |

Voicemail Password (fix) : |

Yoice Mailbox Size (messages) . I—

Fax Mailbox

Enable Fax Mailbaox : No -

Send Fax Message Motification To Email : Yeg w
Attached Fax File To Notification Email : fes -

Send Yoicemail Motification For Incoming Fax : Yas -

Fax Mailbox Size : 20 -

This picture show the part of configuration about the extension that you can set voicemail configuration . This
part has not shown if you don’t be enable mailbox.
Phone Lock You can lock your phone automatic by refer to your mailbox password for each phone. When user is not at
his/her seat, it can protect another person use his/her phone. You can press 99 to lock your phone. Then system will ask
your password. After you send the correct password, you can choose between press 1 to lock your phone and press 2 to
unlock. After you hang up. System will be set the phone as you choose.
Whisper you can join to talk with someone that is talking with another person but the person who call from external line
will not hear. Only the internal line can hear. It can help an agent who cannot answer the customer’s question. You can
press *97 and the destination number that you want to join that call. For example, number 1002 is talking with the
customer, you’ll press *97 1002 to join and advice agent.
Private Whisper you can join to advice and tell something to agent only, but the person who use internal line cannot
reply to you. You can press *98 and the destination number. For example, number 1004 is talking with the customer. You
want to tell something to number 1004. Then you press ¥*98 1004 and tell him/her. Number 1004 will hear you, but
customer doesn’t.
Channel Spy You can listen another person talks without the speaker’s knowledge. You can press *99 and destination

number. Then system will ask you the password following the below picture.

15, Channel Spy * Il 1 EE Password:|1234

- Agent Login Number this feature is to be enable agent that I set on menu Call Features -> Agent

Roaming Station Register/ Dial-out Roaming is a general term referring to the extension of connectivity service in a
location that is different from the home location where the service was registered. For example, your phone number is

1001 but you must move to another place that has the phone with number 1002. You can roam your number (1001) to

Chapter 3 System Features



this place (1002) by using the feature. You can press * ** and your phone number (in this case is 1001). When it has call

to number 1001, it’ll ring on phone number 1002

Before you use roaming station register/Dial-out, you must set permission to be roaming in extension menu.

And Edit the number that you allow to use roaming feature following this below picture.

Plextel System: \@J

Show All | Close Al
* Status

* Report

Fax
‘Call Control
 Call Features
* Sounds
Incoming Call
Outgoing Call
Schedules
VR
Site to Site Setup
» Manual Config
* Voice Interface
Log
* Advanced

Extension Manager
[ View Extensions ] [ Add SIP Extension ] [ Add Multiple SIP ] [ Add IAX Extension ] [ Add Analog Extension ] [View All,Add Follow-Me Extension]

D';Udal" 1 - 30From 30 ExtensionImport|  _ Browse.. Data Import _|__ Extension Export
Page 1 -

[” Humber TypeGroup Pickup Call From BLFI/RO/RINTLangAP ﬂ';np": DIDFollowme Roaming User Email Vmailm:ﬁ:mﬂl'rt
r ]l_ggﬂs:a?‘; sip  Default:Default:Default W v o x Thai x| none - nicrora @hotmail.com g
[~ 1001:twosip Default:Default:Default ¥ o « % Thai « snom360 v v v 9
r iggi sip  Default:Default:Default ¥ o o x Thai x| none v v
r iggg sip  Default:Default:Default v o o x Thai x none v v é
r iggj sip  Default:Default:Default W o o x Thai x| none v &
r igg; sip  Default:Default:DefaultDefault:Default:Default % o  x Thai x none v v £
r iggg sip  Default:Default:Default X W o % Thai x  none v v 2
r igg; sip  Default:Default:DefaultDefault:Default:Default % o  x Thai x none v v £
r iggg sip  Default:Default:Default X W o x Thai x none v 174
r iggg sip  Default:Default:Default X o o % Thai o yeslinkizs v v &2
r ig}g sip  Default:Default:Default % o o o Thai o yeslinkt2s v Q

Choose yes @ allow roaming station feature

Call Features:

Ring Timeout
Pickup Call from

Record Incoming Calls
Record Outgoing Calls
Support Intercom
Allow BARGE Call
Default Language

20 -

Default:Default:Default
poise:eng:testl 234

% yegs " Mo
* yes 1 No
-
-

Thai -

Allow Roaming Station Feature

3.3. Paging

Paging is the one feature on Plextel System, that is a group of intercommunication. It call one number that set

on paging. Then caller can call to that number to talk with other member in paging group

You can create paging number at menu Call Features -> paging as the below picture.
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™ Call Paging
Plextel System: ¢ [ViewPaging] [ Create Paging]
%

Show All | Close Al
* Status
¥ Report
Group Manager
Extensions
Fax
Call Control

~* Call Features
Conference

Features Code [ System
Setup

Paging

New Features

Next, go to Create Paging tab. You’ll see this part.

Call Paging
[ view Paging ] [ Create Paging ]
Add Paging

Paging Mumber

Phone Members (add Multiple)

Select Phone anne -

Agent Members

Then you set number to use paging and select the extensions that want to be a member in paging

Call Paging ;E EE

[ View Paging ] [ Create Paging ] 8000

Add Paging ao01

Paging Mumber 9002

ano3

] ano4

Phone Members (add Multiple) 9005

Select Phone gg g?
o008 Jembers |

After you add member finish, you’ll see paging member list as the example below.
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Call Paging
[ View Paging ] [ Create Paging ]
Add Paging

Paging Mumber W

Phone Members (add Multiple)

Name Member Delete
4444 9005 Del
4444 9006 DE||
4444 9007 Del
Select Phone 9007 -

APPLY I

For example, we set number 4444 is the paging number and members of this paging are number 9005, 9006, 9007

Call Paging
[ View Paging ] [ Create Paging ]
r Number

Member

[~ 4444 9005
9006
9007

Page 1: Delete Selected

Edit
74

Before using paging, you must set the permission of user at call control menu

Call Control
I [
b
Group Name # Eﬁl E -
piBlctes Ble £
_ ggggﬂégswéﬁag
Sy e §EEhhlmb X
B8 & >33 888338 %3
a1 a2 o e el ) o
FIFIFICCCFFCFFVF v -
2 (A o o o A CAUCAL )
test_site L Ly g C|\C
xxx(5IP) O L o o o o
dsdsd(SIP) [l oAl o o o o o o o i
hello_world I 1 o |
testitt I o o o o o |
111 (O L o o o o
ol [ni[si[ni[nisi[si[sisis=ssn =~
Pagel:
Extensions Group . Outgoing Call Call Features  Site-to-Site | |Queue . IVR FAX
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3.4 Virtual Number

Virtual number is the number that is created to use in other features easily. You can create the virtual numbers
as much as you want. And the virtual number must not be same as the existed number.

You can create a virtual number in menu Call feature -> virtual number as picture is below.

Virtual Number

Plextel SVSIEITIZ 5 [ virtual Mumber Group ] [ Add Mew Group ]

Show All | Close Al
> Status
> Report
Group Manager
Extensions
Fax
Call Control

= Call Features
Conference

Features Code / System
Setup

Paging

New Features

New Macro

Agents

Queve

CallerID Routing
Customer Satisfaction

Setup
Virtual Mumber

Then you create group of virtual number to set permission at Call Control menu

Virtual Number
[ virtual Mumber Group ] [ Add MNew Grl:uup*_

Group Name ; kall_u:enter

Virtual Number

[ virtual Mumber Group ] [ Add New Group ]

Group Name : call_center [del]
Virtual Number Priority What to Do Value edit delete
Add

The below picture shows permission status of group’s user that can use this virtual number group
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Call Control

2
N
Group Name 7 e
dﬁmﬂ §3 N
i qE:ﬁt el i
) g aogﬂﬂgﬁgg
Slxla SEEh e B X
2285 F 628338238 % 38
FIMIMICICIIT ol o o o o o o ol
MMM v I o o ol i A
PPPI‘I‘I‘:S%EI‘I‘I‘I‘I‘I‘I‘I‘I‘
- ‘test_site IS LI
o (SIP) Il o O o o o o o
dedsd(SIF) Il o o o o o o o o M
hello_world I e e e e e e e e e
testttt i e e e e e e e e e R
111 I e e e e e e e e e e
aaa I'I_I_I_I_I_I_I_I_I'I_I_I_I_I_I'-

Page 1:

Extensions Group | OQutgeing Calll Call Features  Site-to-Site | Queus . IVR

Next step, Add the virtual number in group
/& Virtual Phone Number - Windaws Internet Explorer =k ]l
o) i 2000t mororizs 5]
H
Ilrmal Number (Ex,123), '=invalid, 't =timeout

| APPLY I

4 n 3
e Internet | Protected Mode: On o v B105% - N
e __________|

Set the action that what to do. If you click Add what to do, it’ll show action list.
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f500 jcall_center

AddwhatToDo I

APPLY |

When Setting action has done. Apply that to finish setting.

500 jeall_center
Dial Conference - O il B s00 ~ (& |
Hangup - e n

AddWhatToDao l

APPLY |

As the below picture, shows virtual number group that consists of number 500 in group. When extension that allows

permission to use this virtual number group, calls number 500. Plextel will send your call to conference room NO.600

Virtual Number
[ Virtual Mumber Group ] [ Add Mew Group ]

Group Name : call_center [del]

Virtual Number Priority What to Do value edit delete
500 1 Dial Conference 600 & (& |
2 Hangup null
Add

All actions in virtual numbers feature will explain later on chapter 4.2 IVR
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Chapter 4 Incoming Line Configuration

4.1 Schedule is a list of actions from a set of transactions in database. For example, All calls go to IVR in the office
hour and all calls go to voicemail system when It is out of office hour because at out of office hour has no employees
receive calls.

You can set schedule at menu Schedule tab on left hand side. It show as below picture.

Schedules Manager
[ View Schedule ] [ Add Schedule ]

Page ‘1 . ”v ‘

[”  Schedule Name Description Time Range Edit
[ all all Month Date Day Time é
" @ ¥ alTime
B 5 ¥ alTime
i i i alTime
% > * alTime

Delete Selected

You will see the default setting of schedule, “All”. That means this schedule support all times. You can add

new schedule in this page.

Schedules Manager
[ View Schedule ] [ Add Schedule ]
Schedule Details

Name: |

Description:

Add Time Range

APPLY Cancel

From above picture, it has 2 part to set schedule.
Name is the name of schedule such as working time, closed time.
Description is the wording that explain about schedule

Next, you add the range time. You can add many range times as much as you want to set
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Schedules Manager
[ view Schedule ] [ Add Schedule ]

Schedule Details

Name: |

Description:

Add Time Range I

Month Day-of-MonthDay-of-Week Hour  Minute
fram| = i+ ® w|* w|* |%| Remove |
o |[* S IS & M E T s

Month Day-of-MonthDay-of-WWeek Hour  Minute
from| * W E W 2 M1 *F s * v Remove |
to ¥ W W £ Wl F | F e

Manth Day-of-ManthDay-of-Week Hour  Minute
from| * he| IS = w|* *|* |v| remove |

o |[* S IS & M E T s

Cancel I

Then, you set range time as this example. This example shows office hour, is on Mon-Fri 8:30 — 17:00 and Sat 8:30-

12:30

Schedules Manager
[ view Schedule ] [ Add Schedule ]

Schedule Details

Name: I‘n"'.n'orking_'l'lme
Description:

Add Time Range |

Manth Day-of-MonthDay-of-Week Hour  Minute
from| * | I Manday ¥ 8 w30 ™ Remuvel
to |* w|* v Friday |17 %30 |+

Month Day-of-MonthDay-of-Week Hour  Minute
from| * | I Saturday (v |8 v |30 » Removel
to |* w|F v Saturday w112 [v)| 30 [+

Cancel I

Then you click apply to save this configure. It’ll be display as below picture.

Schedules Manager
[ View Schedule ] [ Add Schedule ]

Page |1 N

[~ Schedule Name Description Time Range Edit
[~ Working_Time Month Date Day Time @
* ¥ Mon - Fri 8:30-17:30
2 a3 Sat - Sat 8:30-12:30

Delete Selected
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4.2 IVR (Interactive Voice Response) is the system that receive all external calls and manage the call to dial
following a diagram. You can create [IVR from /VR menu and click to Create voice Menu as the below picture.
Voice Menu

[ Wiew Yoice Menu ] [ Create Voice Menu]
Voice Menu Details

Name

Description

Allow direct call from this menu -

Default Language English
Enable Menu Password —

Intro Sound Intro.way
Invalid Sound Invalid.way
Timeout Sound m "
Absolute Timeout Sound Goodbye.wav ¥
Bxit Sound Goodbye.wav [»
Music On Hold Default »
Absolute Call Timeout (sec) F

Wait For Response (sec) llS—

Wait For Additional Digit (sec) |3—

No Input Max Repeat Times r

Invalid Input Max Repeat Times h—

Direct Call Menu None
Automatic Dial Number Mone W

Name: is the name of IVR

Description: is the detail of IVR to explain how to ivr works

Allow direct call from this menu: when you select this box, you will allow the external line to call the extensions
directly if caller knows the extension. The first sound that plays in IVR is from Intro Sound. This sound should tell all
details how to call extensions. For example, “Welcome to Poisetechnology, please enter your destination number that you
know or press 0 to connect operator.”

If you want the external call can dial to extension directly, you must set permission in Call Control.
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Call Control

[
&
]
C i =
& = 4
u 4= 4
= {e |8 e
Group Hame a0 m - -
oS 1D 4= = -~
CER S R I TR I | ° & o
[T L I A I T = I - o
B — == & 0= |+ > | =L
S 0T |8 | || B W e
O 3| 3|3« 0|0 = S T
= [ B - I I A 1)
= Tl S SR VI o PO U =T A1 R =
L T e B B N = = S I I B R
o S I T - - - B R R = SR R R s R L S =]
Il o o L e
MV M (VT VMMM
i e L e A A L e e L
test_site N o A R
xxx(SIP) i\ e
dsdsd(SIF) i r|rrrririre
hello_world N o o A e
testttt I o A
111 R o S A
. L o
aaa L L L L L L

Page 1:

E:tensions Group . Qutgoing Call| Call Features | Site-to-Site [0 Queue | IVR FAX

As this example, oranage tab is the ivr that has name is main. It set permission that allow default group and sip
outgoing call. That means caller can call directly to extension in default group and call pass through sip outgoing call.
Default Language: you can select basic sound language to use with IVR
Enable Menu Password: If this is enable, IVR must require password to access menu to edit rule. After you enable

this,it will show details about flow diagram.

Enable Menu Password v

Password Sound Intro b

Menu Password I—

Invalid Password Sound Intro w

On Invalid | Hangup v|

Password sound: You can select sound file to play sound to ask password

Menu Password: You can set password for this menu

Invaid Password Sound: This sound will play when user send wrong password

On Invalid: You can select what ivr to do when user enter wrong password. It has 3 choices to choose.
1. Hangup: it hangup when you enter wrong password.

2. Repeat Menu: it ask your password again

3. Goto Previous Menu: it’s back to previous menu
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Intro sound: this sound is the first one to play when it has call into ivr. For example, “Welcom to Poise Technology,
Please press the extension number or press 0 to call operator.”
(If you want to add new sound, you can do that in menu sound -> create voice)
Invalid Sound: this sound will be played when user enter wrong number such as “You enter wrong number, please enter
the number again”
Timeout Sound: This sound will be played when user does not enter the number in time.
Absolute Timeout Sound: This sound will be played when it reach limit time.
Exit Sound: This sound will be played when user enter wrong number and reach the limitation of enter
Music on Hold: Select this to use in [IVR
Absolute Call Timeout(sec): If you set this time, it will cut off a call when it reaches time limitation.
Wait for Response(sec): when you set this. [IVR will repeat itself if caller don’t enter number in time.
Wait for additional digit(sec): during time that IVR get the number and it has no response. IVR will repeat itself when
it’s out of time.
No Input Max Repeat Times: the number of repeating when user doesn’t enter the number in time.
Invalid Input Max Repeat Times: the number of repeating when user enter wrong number.
Direct Call Menu: If you want to jump to another IVR when IVR finish playing sound, you can select in this IVR list.

Automatic Dial Number: You set that ivr can automatic dial to assigned number when it plays intro sound finish.

After that you apply configure and save change. IVR will save configure and then you can edit again to assign

each number has what action to do.

Voice Menu

[ View Voice Menu ] [ Create Yoice Menu]

/

B VR Description Intro Sound Edit
[~ 5545 545 Intro.wav &
111 11111 Intro.wav &
[ main min Intro.waw  — c_z
Page 1:  Delete Cancel x

From the above example, edit IVR to add number what to do.
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Voice Menu
[ view vaice Menu ] [ Create Vaice Menu]
Voice Menu Details

Name [nain

Description [main

Allow direct call from this menu v

Default Language English |+
Enable Menu Password

Intro Sound Intro.wav [
Invalid Sound Invalid.wav v
Timeout Sound Gaoodbye w
Absolute Timeout Sound Goodbye.wav ¥
Exit Sound Goodbye.wav v

Music On Hold Default
Absolute Call Timeout (sec)
Wait For Response (sec)

Wait For Additional Digit (sec)
No Input Max Repeat Times
Invalid Input Max Repeat Times

IIWWWﬂWIIHUIIjI

Direct Call Menu Mone
Automatic Dial Number MNone s
Number Priority WhatToD0 Value Edit Delete
1 1 Dial Group Default%:%4Default3%:Default &
2 Dial Extension (serial) 1000

(Cadd number_])

When you add number in Menu edit [VR, it has new window appear to you for setting what to do

/= ADD NUMBER - Windows Internet Explorer E E”E|

£ htp:/(192.168.0.124/libs ive_nong_addnumber, php?riame=main | bt E

oy ]

Assigned number is in box for example, assign number 3 for do some action. It’ll show following below

picture.

E main

AddWhaiToDo _|

APPLY |

When you add what to do once time, it shows display like the below picture.
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3 main
Hangup V| E

AddWhatToDo |

APPLY |

The select box has a drop down list. You can select many actions in list.

|3 l'nain
Hangup |ﬂ E

dNdgLup
Dial Group
Dial Extension (serial)
Dial Extension (zll)
Go to Queue
Re-Dil
Dial Conference
Leave Voicemail
Playback Sound
Hangup
Repeat Menu
Gota Menu
Gota Previous Menu
Set Language
Announce Call Mumber

Vait
Follow Me
TRAMSFER(PABX)
Call Custom APP
Gotao Custom APP
Dial External Line

Each option is the action that you must assign to IVR. Before setting this, you must learn about details of all action
because some actions need to use together. In this version, you can set many actions to relate with sound file. All action
can be explain following this.

1. Dial Group:

E] Jmain
Dial Group v | @ B | DefaultsseDefaultasbefautt v | B3

AddwhatToDo I

Ion No Answer

AddOnAnswer I

on Unavailable
AddOnUnavailable |

appLY |

This action is set to dial group by refer to group list. That time is the ringing timeout and the last box is to select
group . Notice that it has 2 options. There are On No Answer(when no person receive call) and On Unavailable (When

phone is disconnected). You can assigned it what to do when 2 events have occurred.
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2. Dial Extension(serial)

E Jmain

Dial Extension (serial)

AddwhatTaDo I

Ion Ho Answer
AddOnAnswer I

iOn Unawvailable
AddOnUnavailable

ApPLY |

1000
1001
1002

v @R @100 B

This action is to dial to specified extension that you assigned.

3. Dial Extension (all)

|3 h‘uain

Dial Extension (al)

VO ®[1000 v

AddWhatToDo |
1002

1003

IOn No Answer 1004
AddOnAnswer I 1003
1006

1007

IOn Unavailable 1oos
) 1009
AddOnUnavailable I 1010
APPLY I 1%13

T
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This action is liked a Dial Group but it assign the number and not refer group. For example, you assign nt @
1000, 2000, 3000 to ring at the same time. But those numbers are in different group.

|3 l'nain

Dial Extension (all)

9
ALY

Dial Extension (all)
Dial Extension (all)

addwhatToDa_|

ion No Answer
AddOnAnswer |

0On Unavailable
AddOnUnavailable I

APPLY |

4. Go to Queue

|3 l'nain
Go to Queue V|®Full &‘i| Queue_Agent V| E

AddWhatToDo |

On QueueExit

AddOnFinish I
ALY |

This action is to transfer call to queue. On right hand side will show queue list for selection. And another part

that is On Queue Exit, it is to assigned action what to do when no person receive call in queue.

5. Re-Dial: This action is to repeat dial this number again. Then it must follow the Dial Group or Dial

Extension
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E fmain
Dial Group v |©Ofo B | Default%%sDefault¥sseDefaut v | &
Re-Dial <« a

AddWhatTeDo |

on No Answer
AddOnAnswer |

on Invalid
AddOnUnavailable |

APPLY |

6. Dial Conference: This action is to dial to conference room

|3 i‘nain

Dial Conference V|@ ul

8 0

AddWhatToDo |

On Finish

AddOnFinish I
APPLY |

7. Leave Voicemail: This action is to leave your message or speech on system. Message will be in voicemail

box
|3 l‘nain
Leave Voicernail vl@l-null— B |1000 » B3
1000
[__addwhatToDo | 1001
1002
. 1[IEI3

IOn Finish 1004
AddOnFinish I 1003
1006
APPLY | 1007
1008
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8. Playback Sound: this action is to play sound file. You must record your sound(sound -> Create vo @

plextel before set this.

|3 hain
Playback Sound v|@Fd Bl ~ B
1000

AddwhatToDo I =

Goodbye
. Dialing
On Finish Trivalid

AddOnFinish | Molnput
fest
APPLY |

9. Hangup: This action is to hang up or drop call.
10. Repeat Menu: This action is to repeat the last action again.

11. Goto Menu: This action is to jump to another [IVR. The right hand side shows IVR list.

|3 hain
Goto Menu V|@Full G 3]
AddWhatToDo I 5

nmain

APPLY |

12. Goto Previous Menu: This action is back to the previous menu

13. Set Language: This action is to switch languages to set as default

E [nain
Sef Language v @Fi B[engish v ]
AddWhatTaDe | Lsh

Customl
Customz

'On Finish

AddOnFinish |
appLY |

14. Announce Call Number : This action is to announce number that caller enters it before do the next step.
For example, you set number 3 for this action, system will play sound “You press number 3”
15. Wait: this action is to wait the user’s number who cannot receive call at this time. When it reach a timeout,

it will do the next action.
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|3 l'nain
Dial Extension (serial) |+ |®|20 = 3]
Vait v| @0 a2

AddwhatToDo |

iOn Finish
Re-Dial « B

AddOnFinish |
APPLY |

16. Follow me: this action is to set system jump to follow me that is created in extension menu (Extension ->

Add Follow Me Extension). It has a select box to select the extension to set follow me action.

|3 h’naln
Foloww Me || & ot B |none
-~
AddWhatToDo I 1000

- [

ion Finish

Re-Dial ~ 83
AddOnFinish I
areLy |

17. Transfer (PABX) : this action is to transfer call to PABX from IVR. In this case, you must connect PABX

with plextel server and assign destination number on the right-hand side tab as the below picture.

3 fmain
TRANSFER(PABX) v |@ful & [1001] 2

addwhatToDa_|

APPLY |

18. Call Custom App: this action is to use the additional function. You can add new feature at Menu Call

Features -> New Features and select feature on right drop down box.
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3 main
Call Custom APP v|©@Fa S [rExra— | &

AddWhatToDa_|

iOn Finish
Re-Dial v 2

AddOnFinish I
APPLY |

19. Goto Custom App: this action is liked as Call Custom App but it’s different at the call that go to custom

app, it cannot return to IVR .
20. Dial External Line: this action is to dial to the external line. You must assign trunk to call out as the

below picture.

|3 l'nain
Dial Externzal Line V|®|2EI B | trunk%a%sip%basdf v )

sddihatTodo | trunk%:%sip%%%asdf
frunk2s%edahdi%aetest

0On Finish
Re-Dial v 8

AddOnFinish I
ALY |

21. Read DTMF: this action is to read the number that caller enter.

To Do
Read DTMF ~ 7o VAR1 ~ Playback INtro  ~ Maxpigit unlimited v attempts 0~ Tmeout default ~ B2

AddWhatTeDo

Select “To Do” as a Read DTMF

To: You select the variable to keep value

Playback: is the sound to announce when caller into this menu such as “please enter your member’s number
and press # when you finish”

Max Digit: it is the maximum digit that caller can enter

Attempts: is the number of time that callers can enter their number. IVR will repeat this menu to prompt record
your number again.

Timeout: is the during time that IVR will count when playback sound finish playing

22. Check Database
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| Description:
To Do

Check Database * NONE = argi NONE = apgz NONE * argz NONE ~ varighle VAR1 - @

| AddWhatToDo

- select your database

- ARG1-3 are the data that you want to compare with database

- Variable is the value that it returns

23. Verify Variable (not exist) is to verify the value that you want to check it

uescripoon:

To Do
Venfy Vanable (not exist) *  nName VART ~ Playback Intro ~ To-do Hangup ™ RetryBeforeExit 0 ™ Playback(exity NONE  + To-dofexity Hangup -

Name: is the name of variable that you want to check it

Playback: is the sound file that be played when the value of variable is null

To-Do: is the next action will do when finish checking value of variable if the value is not null.
RetryBeforeExit: is the time of checking value

Playback(exit): is the sound file that IVR will play when it check value completely.
To-do(exit): After finish checking value, you can set IVR to do next action at this.

23. Playback Variable: IVR will play value that keep in variable

To Do
Playback Variable *  Name VAR1 * Type Say Digits -~ B

AddWhatToDo

Say Mumber
Flayback Sound
Say Alpha

Say Phonetic

Name: is the variable that you want to announce the value
Type: is the type of value. For example, if the value is number you must select “Say Number” if the value is
digits, you must select “Say Digits”.

24. Label Marking: is the marking position in IVR. You can mark position that you want the IVR return to

play at this step.

To Do
Label Marking * pame Labell - E

AddWhatToDo

Name: is the name of Label
25. Goto Label Condition is the action that jump to Label if the condition is true or false.

To Do
Goto Label condition T WhenVaRIABLE VART = Equalto YesGoto Labell = npgoto Labell - 8

AddWhatToDo
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When Variable: choose the variable that you want to check in condtion
Equal to: is the value that you want to compare with variable

Yes-Goto: if the condition is true, [IVR will go to Label that you assigned
No-Goto: if the condition is false, [IVR will go to Label that you assigned

26. SayDate Time: IVR will play date and time

To Do
SayDateTime * Type Currenttime + pgrmat 28bY v T

AddWhatToDo

Type: is the variable that you want to play
Format: is the date and time format
a = day, e = date, b = month, Y= year
27. Background Sound: IVR will play selected sound file. The background sound is different from the
playback sound in the during time that you can enter the number. As background sound, you can press
number while the background sound is playing but in playback sound you cannot press the number until

playback sound finish playing.

1D LMD

Background Sound * © null B Goodbye - 8 &
AddWhatToDo |

28. FAX: send fax to the selected number

To Do
FAX ¥  Tonumber hd E I_
AddWhatToDo

4.3 Incoming Call Setting: incoming call setting is an action that manage what to do when it has incoming call

come to system. In menu incoming call at left hand side, it shows as the below picture.
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Incoming Call
[ view Incoming Call ] [ Add Mew Incoming Call ]

Display 1 - 1 from 1

[ Trunk Destination DID Description Edit
[ trunk:dahdi:test 0 time quele Queue_Agent - ﬁ
Page 1:
Delete Selected | Cancel |

Select Add New Incoming Call, you will see this page.

Incoming Call

[ view Incoming Call ] [ Add Mew Incoming Call ]

Add Incoming Call

Trunk | trunk:dahdiztest | [ paBxdink

Description |

Support DID

Incoming DID |

Replace CallerID |

Extensions Ring Timeout(sec) 40 »

Add time based handler |
Actions

When * | __ galact schedule - v | Destination® | gojact v

Value
Remove

apeLy | cancel |

Trunk : is shown the trunk list to select trunk that has incoming call pass through as the below picture.

Add Incoming Call

Trunk trunk:dahdi:test [ PaBy-link
Description
Support DID gateway:sip:test Sys

Incoming DID

From Example, You will see trunk list and you can select only one trunk.

PABX-link: when you check in check box in this PABX-link, Plextel must connect to PABX.

Description: is to describe the details of this incoming call
Support DID: if you select “yes” , you must have a number to match with incoming call.
Replace Caller ID: enter the number in this box for replace the number that show on system or don’t want to show the
called number.
Extension Ring Timeout(sec): is the ring timeout of Extension (sec)
Add time based handler: when you press this, the time base handler will appear in this page. It use this function when
you want to do different action in the different period of time. For example, Incoming call will go to IVR on office hour

and goes to voicemail on out of office hour.
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When: is to select the schedule list to set action
Destination and Value: two parameters are related each other. When you select different destination, the value will be
shown the different destination value.

After that, you press add incoming call. WUI will be refreshed to the main page of incoming call interface and

show your incoming call.
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Chapter 5 System Management
5.1 Manage System Administrator is System of Management to set the username and password of all user. The person
who can access to create and edit this part of system, must be the Administrator only. And You should set the permission

of user cannot allow to edit configuration. The below picture will shows login page

PLEXTEL-SYSTEM

Clear

If you login incorrect username and password, you cannot access to configure it. The default username and
password are

Username: admin

Password: plextel
5.1.1 user Manager

You can set or edit the new username and password at menu Advance->Manage Admin like as this example

picture.
Users Manager

[ View users ] [ Add user ] [ Copy users from extensions ]

[7] web Username Phone Number Phone CallerID Extensions Web User type Enable CRM CRM User Type Edit
[ monitor Monitor &
[ user User &

admin Administrator Enable Administrator &
[F] 1008 1008 1008 SIP/1008 User &
[F] 1007 1007 1007 SIP/1007 User &
[7] 1008 1008 1008 SIP/1006 User &
[7] 1005 1005 1005 5IP/1005 User &
[F] 1004 1004 1004 SIP/1004 User &
[F] 2000 2000 2000 51P/2000 User &
[F] 1003 1003 1003 dahdi/s User &
[F] 1002 1002 1002 1AX[1002 User &
|:| 1001 1001 aszaa SIP/1001 User z
[ 1010 1010 1010 SIP/1010 User &
[F] 1008 1008 1009 SIP/1009 User &

Page 1: [ Delete Selected ] [ Cancel ]

If you want to edit the username and password, you click at command. Then you can edit that user as below

picuture.
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Users Manager

[ View users ] [ Add user ] [ Copy users from extensions ]
Add user

Select Level User Izl

Web Username
Password

Re-entry Password

Phone Mumber Mone |E|
Enable CRM Mo |E|
CRM User Type Mormal User Type E

| APPLY | | Cancel |

Select Level: it has 3 level to setting for each user — Admin, Monitor, and User. Each level can access different
level web page. Admin can access all pages, and user can access some page only such as voicemail.

Web Username: is the name that use to login web page. You should set username same as extension to easy

manage.
Password: Password to login web page
Re-entry Password: enter same password again
Phone Number: the extension number of user
Enable CRM: allow user to use CRM
CRM User Type: Select CRM level

5.1.2 Change Password

When you login to plextel by user level, it shows some menu only. But you can edit your password at menu

Change Password (on Top tab bar) and you can also change your voicemail’s password.

~N ‘ Chapter: Chapter 3 System Features



-

.
& 192.168.0.125/libs/changepassword.phpZuser=... L= (). [P

() 192.168.0.125/libs/changepassword.phptuser=59

Web Access Password
Cutrent Password :| |

MNew Pazsword :| |

Confirm Password :| |

Voicemail Password
Password :| |

| APPLY | | Cancel |

If you want to add new users, you can do it at menu Add Users

User Manager

[ View users ] [ Add users ] [ Copy users from extensions ]

Add users

Select Level
lsers |

Password |

Re-entry Password |

appLy | cancel |

When you add new user. System will show the new one as this below picture.
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Users Manager

[ View users ] [ Add user ] [ Copy users from extensions ]

["] web Username Phone Number Phone CallerID Extensions Web User type Enable CRM CRM User Type Edit
[ monitor Mornitor V4
[ user User V4
admin Administrator Enable Administrator V4
[ 1000 1000 1000 SIP/1000 User Enable V4
[@01 1001 1001 SIP/1001 User Enable Q)
[ 1002 1002 1002 SIp/1002 User Enable Vi
[ 1003 1003 1003 SIP/1003 User Enable V4
[ 1004 1004 1004 SIP/1004 User V4
[ 1005 1005 1005 SIP/1005 User é
[ 1008 1006 1006 SIP/1005 User Enable V4
[ 1007 1007 1007 sIP/1007 User é
[ 1008 1008 1008 SIp/1008 User Enable V4
[ 1009 1009 1009 SIPf1009 User é
[ 1010 1010 1010 SIP/1010 User Vo4
[ s000 5000 5000 SIP/5000 User é
[ 5001 5001 5001 SIP/5001 User é
[ s002 5002 5002 SIP/5002 User 4
|:| 5003 5003 5003 SIP/5003 User ¢
[ 5004 5004 5004 5IP/5004 User g
[ 2010 2010 010 SIP/2010 User Vo4

Add user in menu user manager, is to set the permission to edit the data in the future. At this time, the user can

allow to set the value as the admin only.

5.2 LAN Network Setup is to set the IP Address of server. You need to set it as static IP because all IP Phone must be

registered to this server. You can set IP Address at menu Advance->Network Setting as the below picture.

Network Setting
[LAM] [WAM ] [ Static Routing Table ] [DMS ] [ DDMS ] [DHCP Service ] [ Firewall Service ] [ NTP Service ]
[etho] [ethil (no device) ]

TCP/IP SETUP {eth0)

Made | Static Setting |

IP Address (192 | [168 %] [0 |»|[124 v]
Subret Mark | 255 [»| [255 v 255 v| [0 (+|
Gateway | 142 V|. | 168 | | 1] hd | | 22 V|

APPLY

After you finish setting or editing IP address. It has the red tab on screen to restart network.

5.3 WAN Network Setting is to set the WAN IP address for the phone that is on the other place or different
network to register to this server. You must set the real IP address that is given by ISP (Internet Service Provider). The
advantage of the real IP address is the transferring voice signal is working most efficiency because it does not pass
through NAT or Firewall. Then you must set real IP address at server and set the ADSL Modem as the bridge mode to
forward packet to server. You can set username and password that ISP give it to up at this menu Advance -> WAN

Network Setting
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Network Setting

[LAM] [wWaM ] [ Static Routing Table ] [DNS ] [DDMS ] [ DHCP Service ] [ Firewall Service ] [ NTP Service ]

WAN Network Setup

ISP Login Name (ADSL -
Account) plextel @truehisp
Password [sssssne

Start at Boot " Yes ™ No
aprLy | cancel startwan | stopwan |

From this example, It set the username from TRUE(ISP). Then you enter the username, password and apply
this. It will activate immediately.
5.4 HA Setup is to backup system of server to have more security. It’s necessary to have the another server to reserve
when the main server has something wrong. The reserved server must has same configuration as the main server.

You can set this HA at menu Advance -> HA Setup

High-Availability Configuration

| ENABLE
Server Type ¥ Master { Slave
Virtual Server IP-Address ,22_ ,22_ ,22_ ,22_

Optional Configuration
Broadcast Interface ethd [«
Check Interval Time (ms) IEDD—
Declare Dead Time (Second) |2—
Warm Time (Second) ll—
Init Dead Time (Second) |1207
Auto Failback @ on  off
Enable Debug log * on O Off
Enable log " on " Off

appLy | cancel | | | _Defaut |

From this example, You can assign the virtual server IP-Address and select type of server. For main server is
selected as Master and reserved server is selected as slave. Then you must enable and apply it. You must reboot both of
them before HA setup works.

5.5 Firewall/NAT Setup is the setting about the security of system. You should set this part when you allow clients or

IP-Phone can register to server. You set this part at Advance->Network Setting-> Firewall Service
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Network Setting

[LaM] [wamM ] [ Static Routing Table ] [DMNS ] [DDMNS ] [ DHCP Service ] [ Firewall Service ] [ NTP Service ]
FIREWALL /f NAT Setup
I EMNABLE Firewall

Serwvice from WAN {PPPoE)

I Allow Access SIP

I Allow Access TAX2

I Allow Access RTP

I Allow Access NTP

I Allow Access WEB-Interface

I Allow Access Terminal

I Allow Access PBX Manager

Service from LAN (Ethernet)
I+ Allow Access SIP

IV Allow Access TAX2

I+ Allow Access RTP

IV Allow Access NTP

I Allow Access WEB-Interface
I~ Allow Access Terminal

I+ Allow Access PBX Manager

HNAT Setup {(Source NAT)
I Emable Outgoing SMAT

Internal Server Setup {(Destination NAT)
Enable TCP/UDP wWaAN Port-Number Server IP-Address Server Port-Number

- e T | I
r SV SR I I I
— — e T ] I
— e T | I
r a3t B I I
- e T | I
r SV SR I I I
- e T | I
L e T I I
- VAL S | I
— — e T | I
- a3k B I I
- e T | I
- e T | I
— — e T | I
— e T | I
Apolv | Cancel | Default |

Description of these values are following this:
- Enable Firewall: click this to enable firewall
- Service from WAN(PPPoE): service list that allow to access from outside
- Service from LAN(Ethernet): service list that allow to access from inside
- NAT Setup: is the NAT setting

- Internal Server Setup: is to set up port forward to login to another server from outsite

5.6 DNS Setup: DNS setup can set at menu Advance -> Networking Setting -> DNS

Network Setting

[LAM] [ WAN] [ Static Routing Table ] [DMS ] [OONS ]
DNS Setup

Name Server 1 [203.144,207.29

Name Server 2 |2D2.E|. 100.1

Name Server 3 |

Name Server 4 |

APPLY
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5.7 Dynamic DNS: Dynamic DNS will use when your office has no real IP Address. You must register with Dynamic
DNS Provider before you set this part. Then you will get the username and password and you can setin this menu

Advance -> Networking Setting -> DDNS

Network Setting

[LAM] [WaM ] [ Static Routing Table ] [DMS ] [DDMS ] [ DHCP Service
Dynamic DNS

[ Active

Service Provider www.dyndns.org | W

Host Name

E-mail Address

User

|

|

|
Password |
[ Enable Wildcard

speLy | cancel

5.8 DHCP Server: is to set server to auto configure IP Address to clients or other devices. You can set DHCP at this

menu Advance -> Network Setting -> DHCP Service

Network Setting
[LAM] [wWaMN] [ Static Routing Table ] [DMS ] [DDMS ] [ DHCP Service ] [ Firewall Service ] [MTP S
[ DHCP Server Configuration ] [ DHCP Leased Status |

DHCP Server Configuration
v ENABLE

APPLY

Subnet Value [192.168.0.0
Domain Name plextel
SubnetMask Value |255.255,255.0
Gateway IP Address [192.168.0.22
Primary DNS Server |2EI3. 144.207.29
Secondary DNS Server |2EIE. 144, 207,49
HTP Server |192. 168.0,22

Option tftp-server-name

Option bootfile-name
Client Start IP Address
Client End IP Address

Cancel

[192.168.0.124

lautu:npru:n‘-;isin:nn,-"sn-:nm.ht‘n

[192.158.0.130

[192.158.0.240

Subnet Value: IP Address Network

- Domain Name:

Subnet Mask Value: Subnet Mask

* Required For AutoProvision

Gateway [P Address: You must set your IP Address of Gateway same as [P Address of Server [P-PBX

- Primary DNS Server

Secondary DNS Server

NTP Server: set it same as [P Address of Server IP-PBX to synchronize time to server.

Option TFTP-server-name: the computer that share file to client (set IP Address f server IP-PBX)
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- Client Start I[P Address: Start [P Address to automatic configure

- Client End IP Address: Last IP address to automatic configure

5.9 Backup & Restore: This feature is to save and restore configuration of system. You can backup or restore at menu

Advance -> Backup & Restore

Backup & Restore Manager

[Backup ] [Restore ] [Restore Factory Default ]

Last backups

backup-2010-06-28--03-25, tar.gz 29,/06,/2010 20:25 Download | Delete

Create new backup | Cancel |

Comment

From the example, when you click the create new backup button, it’ll create the last backup file and file name is the date
and time of file when it is created. You can download file to save as another location on your computer for using restore

when system has problem or something wrong.

Backup & Restore Manager

[Backup ] [Restore ] [ Restore Factory Default ]

Last backups

backup-2010-06-28--03-25.tar.gz 29,/06,/2010 20:25 Download | Delete

Create new backup | Cancel |

Comment

You can reset all configuration by click at Restore Factory Default. All configuration will be deleted.
5.10 License Management: is to add license into system. 1 license is 1 extension. At first license will be add following
customer’s requirement. If customer wants to add license, you can contact to sale. You can add license at menu Advance-

> License Management

License Setup
Serials Number: 00P0-27L0-0EX0-TO13-L047-P023

License Details : 16/06/2010
Client : 100
Remark: demo

License Details : 16/06/2010
Client :
Remark:

License Details : 14/06/2010
Client :
Remark:

Total License: 100
License File| Browse... | APPLY |
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From the above picture, it shows number of license is 100 licenses. If you want to add more license, you contact

to sale of poise technology and they will send license to you.

5.11 Call Details Record(CDR)

CDR is from Call Details Record, that is the vital part of VoIP telephone system because it records all details

about the telephone system such as incoming call, outgoing call. You can see this menu at upper tab of plextel software

Home | ViewCDR | DataFiter | Logout

Call . . Frol To . . _ . Disposition

No pte Description  DirectionThrough  Value Last App CallerID Mmber | Number Channel Duration BillsecDisposition (details) Group/Con

2010-06- "1003" Default¥:3e

130 Normal_Call Internal Hangup e 1.]\51> 1003 1002 SIP/1003-0000000a 50 15 AMNSWERED NOAMSWER Default%:%
11:33:17 R Default

2010-08- "1006" Default3:%

2 30 Normal_Call Internal Dial e l':l;’ > 1006 1009 SIP/1006-00000008 3 a MO AMSWER CANCEL Default¥:%:
11:32:59 SRR Default

2010-08- "1006" Default3:%

3 30 Normal_Call Internal Hangup ,1IJ;,> 1006 100 SIP/1006-00000007 12 1z ANSWERED Default¥:%:
113216 SR Default

2010-06- "1006" Default¥%

4 30 Normal_Call Internal Dial © 1006 1009 SIP/1006-00000005 1 o MO AMSVWER CANCEL Default¥:%:

- <1006

113106 Default

20 . . Default¥%

530 Internal Dial ,IE§§2> 10z 1003 SIP/1002-00000002 10 8 AMSWERED CAMCEL Default¥:%:
11:30:14 N Default

2010081 sl Cal Leave 1002 Pefault %%

6 30 ki i 'S Internal  Features vaicemal  VoiceMai 10025 1002 1002 SIP/1002-00000000 & 4 ANSWERED Default3:%
11:30:05 He=mel B Default

5= Local{1003@0efault® Default®:%:

7 Attended_Transfer Internal Hangup 1002 SIP/1001 SIP/1003 %eDefault3c¥eDefault- 3 3 ANSWERED CHANUMAVAIL Default%%s
020f,2 Default

Local{1002@0efault® Default®:%:

g Attended_Transfer Internal Dial 1002 SIP/1001 SIP/1002 %eDefsult?e¥eDefault- 25 0 MO AMSWER CAMCEL Default3tk
3142,2 Default

I . Default¥:%:

9 3 Normal_Call Internal Hangup 1002 002 1001 5IP/1002-0000001b 73 19 ANSWERED NOAMSWER Default%:%
1110128 <1002 Default

2']1‘]-‘]6-N | Call Leawi "t Default¥:%:

10 30 plormal .Ia #38 Internal  Features Voicemal  VoiceMail e 1001 1002 SIP/1001-00000012 50 18 ANSWERED Default¥%%
1 1:08: 39 YOI <1001 Default

2']1‘]-‘]6-N I Call Leaw "t Default¥:%:

1130 plorma LEILEAYE Internal  Features Voicemal  VoiceMal e . 1001 1002 SIP/1001-00000017 41 36 ANSWERED Default®c%
T 1.ngeag Voicemail <1001= et

-

From this above picture, is shows all details. If you want to specify some detail you can use data filter
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Data Filter

Time Range

Description
Direction

Group

Incoming Type
Dutgoing Trunk
Source Mumber
Destination Murnber
Zall Duration
Disposition
Disposition{details)
Last App

Context

® Jun-2010
T | select Date
ALL
ALL
ALL
NONE

NONE w

ALL
ALL
ALL
ALL

| - Jun-2010 v
- Select Date

Seconds

appLy |

Time Range is the range of time that you want to check details of record

Data Filter
Time Range # | January-2010 v -Jun-2010 v
| 2010-06-02 .| 2010-06-15
Description ALL ~
Direction ALL >4
Group ALL b
Incoming Type MNONE i
Outgoing Trunk MNOMNE hd
Source Number
Destination Number
Call Duration ALL hd Seconds
Dispasition ALL hd
Disposition{details) ALL b
Last App ALL hd
Context

You can set description at this

apeLy |
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Data Filter

Time Range

Description
Direction

Group

Incoming Type
Dutgoing Trunk
Source Mumber
Destination Murnber
Call Duration
Disposition
Disposition{details)
Last App

Context

Set Direction

Data Filter

Tirne Range

Description
Direction

Group

Incoming Type
Qutgoing Trunk
Source Mumber
Destination Mumber
Call Duration
Disposition
Disposition{details)
Last App

Context

Set Group

o January-2010
| 2010-06-02

ALL vl
Internal
Outgoing Call
Entering Queue
Check Voicemail
Enter Conference Roon|
Agent Login

Mormal Call Leave Voice
Park Call

Park Call Pickup
Features Code
Incoming Call

Queue to Agent / Agent
Attended Transfer

Blind Transfer

MNormal Call

# January-2010
| 2010-06-02

ALL ~

ALL vl

INTERNAL

ALL w
ALL w
ALL w
ALL ~

| - Jun-2010 w
_| 2010-06-15

<

Seconds

appLy |

w - |Jun-2010 w
.| 2010-06-15

Seconds

appLy |
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Data Filter

Time R "~
e e # | January-2010 v -|Jun-2010 v
| 2010-06-02 .| 2010-06-15
Description ALL b
Direction ALL hd
GFEILIFI .n‘:".LL |ﬂ b
Incoming Type — —
Default%%%Default®e %o
Quitgoing Trunk eng%%epoise%aY%testl
Source Mumber
Destination Mumber
Call Duration ALL - Seconds
Disposition ALL hd
Disposition{details) ALL w
Last App ALL L
Context
appLy |
Set Incoming Type
Data Filter
Time Range iy
January-2010 % - Jun-2010 hd
| 2010-06-02 - 2010-06-15
Description ALL b
Direction ALL hd
Group ALL w
Incoming Type NOME |ﬂ e
Qutgoing Trunk NONE
group
Source Mumber extension
Destination Mumber vr
_ voicemail
Call Duration conference Seconds
Disposition qQueue o
custom application
Disposition{details) fax
Last App callerid routing
Context
APPLY |
Set Outgoing Trunk
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Data Filter

Time Range

Description
Direction

Group

Incoming Type
Dutgoing Trunk
Source Mumber
Destination Murnber
Call Duration
Disposition
Disposition{details)
Last App

Context

o January-2010 | -|Jun-2010 i
| 2010-06-02 . 2010-06-15

ALL v

ALL v

ALL A

NONE w

NONE vl <

pstn

kkk

SEE._ Seconds
ALL w

ALL v

ALL v

appLy |

Menu CDR setup is to set the result of CDR detail. You can select to show some value from this menu

P

LEXTEL

Home | ViewCDR | DataFilter | Setup | Logout

Select field to show on CDR windows

v v v Vv v v v v
Call Date Direction Description Through Value IVR Details Last App CallerID
v v v v v v v 2

Channel Duration Billsec Disposition Disposition(details) Group/Context

APPLY |

From Number To Number

CDR Database Management
Select Time Range
@

c Date Range

ALL
Start Date: Select Date End Date:

Select Date

Last backups

APPLY I

Call Date: shows date and time

Direction: shows calling status. There are 3 typex

Internal — call between extension,

Incoming — when receive call from external line

Outgoing — Call out by external line
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Description: shows details of direction
Through: shows working type
Value: shows through details
IVR Details: shows values of [IVR system
Last App: show the last calling
Caller ID: shows incoming number
From number: shows the caller number
To number: shows the destination number
Channel: shows call routing
Duration: shows time duration from you enter the number to hang up call
Billsec: shows time duration from destination receive call to hang up call for calculating cost
Disposition: shows call status
Disposition(Details): show call status details
Group/Context: shows group name list
The low part of CDR database management is to backup database of CDR. You can select all or select by time
duration.

5.12 Auto Provision: You can set auto provision at menu Advance -> Auto Provision

Advanced Setup
[ Phone Provisioning ] [ Advanced Setup ]
Page 1 -
Enable Extensions MAC-Address PhoneType Am
- 1000 on Thousand none - o e X
" 1001 twio OD0413235C51 snom3sD L Y
1002 1002 nane - &l x
1003 1003 none - @ e
v 1004 1004 004132F3EE3 snom300 L & el
1005 1005 none - & e
1006 1006 nons - @ el x
1007 1007 none - & e
1008 1008 none - & e
v 1005 1009 001565115069 yealinkizs v Fy U X
I 1010 1010 01234567ESEE yezlinkt2s I Y
I 1119 1119 01234554 AAEBE yealinkt22 I Y
W 1144 1144 AAS111272BEE yealinkt20 v ) ‘Ul‘ x
¥ 2000 Mr. TTwo Thoudsand AAAASANSSASS yealinktls ¥ o e X
v 3000 3000 BEEEEEEEEEEEE yealinkil2 v e x
3001 3001 nons - @ el x
3002 3002 none - @ el x
3003 3003 none - & e

Auto Provision is to configure IP-Phone by using plextel register. This feature supports some IP-Phone series. For this
page, you can upload firmware for updating IP-Phone (look at 1.2.1 add sip extension)
From above picture, it shows phone list that activate auto-provision. If you have new firmware and you want to

update to your IP-Phone. You go to advance setup and it shows display as below picture
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Advanced Setup

[ Phone Provisioning ] [ Advanced Setup ]

Firmware Selection

SHOM300 Browse... Upload
SHOM320 Browse. . Upload
SHNOM3E0 Browse. .. Upload
SHOM370 Browse .. Upload
SHOMB20 Browse .. Upload
SNOMS21 Browse... Uplozad
SNOMSTO Browse... Uplozad
Yealink T12 Browse... Upload
Yealink T18 Browse. . Uplcad
Yealink T20 Browse. . Uplcad
Yealink T22 Browse .. Upload
Yealink T26 Browse. .. Upload
Yealink T28 Browse. .. Upload
SNOM Phone Update policy auto_update -

SHNOM Setting Refresh Timer mins (0=never refresh) 120

Phone Username For SHOM admin

Phone Password For SHOM Lt

Phone Interface Password For SHOM D000

Yealink Phone update policy Power on + Repeatedly
Yealink Setting Refresh Timer mins (for Repeatedly rules) 1

Admin Password for Yealink 0000

APPLY
Note: This festures required functional DHCP server, to enable this festure on external DHCP server, DHCP option &6 must be
set to hitp:/ < ipaddress =/sutoprovision/

You can browse firmware for each [P-Phone series that you want and upload it. After you reboot your IP-

Phone, it automatic update firmware.
5.13 SSH Terminal

This feature is in menu Advanced -> SSH Terminal

= Advanced
PEX Advanced Setting

Network Setting
Manzage Admin
Screen pop-up Account

HA Setup

CLI
Auto Provision

Updat:

rsacn
External Storage
Backup B Restore

Licenss Management
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e
| .é’ http://192.168.0.124/libs/ssh.php - Windows Internet Explorer E‘ﬁlﬂ?

kedlad | €] http://192168... v | |4 | X 2§ Googl

l
|

SSH Server/Alias: 152.168.0.124
| Connected to serwer running 35H-Z.0-0penidSH 4.3

Gerver's hostkey (ssh-rsa) fingerprint:
openssh wdS: fa:£5:9d:46:37:55:af:82:ch:bé:6drba:larle:9e: 1
bubblebabble: xugof-karaf-zorah-sasog-vorif-zutev-kupin-lycah-docof-zebyk-cixu:

m

File operations disahled, server identity can't be verified

192.168.0.124 login: root

rootid192.168.0.124's password: *=*rEEET

Last login: Wed Jun 30 13:04:53 2010 from 192.168.0.216
[root@plextel ~]# date

Wed Jun 30 13:15:08 ICT 2010 -

- - - -. | —
' T | »
Dane @ Internet | Protected Mode: On 3 v HO5% -

This menu uses for remote to server by using SSH to run linux command. The PC or Notebook that open this

page, must have Java Runtime on theirs. After open this page, you must input username and password to access this.

CLI

This menu is at Advanced -> CLI

w2 Advanced
PEX Advanced Satting

Metwork Satting
Manage Admin

Secreen pop-up Account
HA Setup

SSH Terminal

CLI

Auto Provision

This menu uses asterisk command to manage it. This menu for user who have asterisk knowledge but cannot
login to system. You can run command by using this menu. For example, You want to show which extensions are online

in plextel. You run command “sip show peers” to show that.
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Dyn Nat ACL Port Status
0 Unmonitored
UNKMNOWN
UNKNOWN
60  Unmonitored

UNKNOWN
UNKNOWN
UNKNOWN

UNKNOWN
UNKNO

UNEKNOWMN
; OK (14 ms)
UMNENOWMN

Go to menu Advanced - Asterisk CLI

== Advanced
PBX Advanced Setting

Metwork Setting
User Manager
Screen pop-up Account
HA Setup
55H Terminal
| Asteriskar |

Auto Provision
External Storage

Update Yersion

This menu uses for the system administrator to access the shell from webpage. User
can use to this shell and input the command and getting display from this shell. Eg. Input
“sip show peers” for display the online extension.

Chapter 3 System Features



Dyn Nat L Port Status
D 0 Unmonitored
) 0 UNKNOWN
UNKNOWN
0 Unmon

LINKNC
LINKNC

0 OK (14 ms)
UNKNOWN
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This menu uses for create the account to use with Screen pop-up API
Go to menu Advanced -> Screen pop-up Account then select “Create Screen pop-up

Account”
Screen pop-up Account

[ View Screen pop-up Account ] [ Create Screen pop-up Account ]
Screen pop-up Account

+ | EMABLE
Username ABCD
Password 1234
Permit Range
Metwork ID 0.0.0.0
Subnet Mask 0.0.0.0
[ apPLy | [ cancel |

CheckENABLE box and specifyUser Name and Password for thisAccount, then click
APPLY. You will get an account for theScreen pop-up API. You can set that program and
login to use it.



Chapter 6 System Monitoring

This chapter, we will introduce the feature for displaying the status and monitoring
the system of Plextel IP-PBX. This feature can facilitate the system administrator to manage
system easily form the web-interface.

Go to menuStatus ->Show Status. This screen will show the real-time status
of PlextellP-PBX
There are 3 parts in this page
1. Network Usage: Shows the status of data transfer (sent/receive/lost) of the network
2. Memory Usage: Shows the status of the main memory using in the system

3. Mounted Usage: Shows the status of harddisk storage in the system

Metwork Usage

Device Received Sent Err/Drop
lo 980,78 MB 980,78 MB 0/0
etho 1.24 GB 3.04 GB 040
wlgl 3.18 GB 316 GB 0/0
sitd 0.00 KB 0.00 KB 040
Mernory Usage

Type Percent Capacity Free Used Size
Physical Mernory T7% 228,37 MB 766,11 MB 994 .45 MB
- Kernel + applications 30% 295,93 MB

- Buffers 16% 160,99 MB

- Cached 1%, 309,19 MB

Disk Swap » 0% 2.00 GB 125.00 KB 2.00 GB
Mounted Filesystems

Mount Type Partition Percent Capacity Free Used Size
g extd /dew/sdaz 10% (1%) 24.03 GB 2,88 GB  25.358 GB
Avar extd /dew/sdas 5 19 (1%) 106.55 GB 1.06 GB 113.78 GB
fboot extd fdew/sdal - 5% (1%) 25308 MB 15,65 MB 285.63 MB
fdewishm tmpfs tmpfs D 0w {193 497 .24 MB 0.00 KB 497.24 MB
Svarfspoolfasterisk/monitor ext2  fdeviram 2 1o (1% 15,35 MB 140,00 KB 1549 MB
fext_hdd wfat fdewisdbl 65 1.25 GB 247 GB 3.72 GB
Smntfsmb cifs  /4/192.168.0.25/temp 158,68 GB 120542 GB1394.10 GB

H6%

(1%

Totals ! 32156 GB1211.85 GB 1540.76 GB

7%

If you would like to shutdown or reboot properly, you can do it by go to menu Status
> Power Management. It will show these 3 buttons.

Power Management

Reboot Restart Service | Shutdown |

Reboot: This button uses for restart the system when it happen some fault from any
running process.

Restart Service: This button uses for restart every services which using with IP-PBX
(eg. Interface card)

Shutdown: This buttons uses for shutdown the system.



6.2 Show Graph

Go to menuStatus -> System Statistic. This screen uses for displaying the status of
hardware using in this system. It can show in graph that makes you compare the status
easily.You can see somevariables; Traffic Analysis, Active CPU Load, Free Memory, New
TCP Connection, Established TCP Connections andServer Load Average.

Traffic Analysis
240.0 k

180.0 k

120.0 k

B0k

Eits per Second

son 0 H B H A
g 10 12 14 16 18 20 =22 0 2 4 a6 & 10 12 14 16

Active CPU Load

0.0

15.0

10.0

5.0

CPU Utilization

0.0

8 10 12 14 16 48 20 2 o0 2z 4 & & 10 12 14 16

Free Memory
1040.0 k

780.0 k 1+

520.0 k

Bute=

Z260.0 k

0.0 k I S N
8 10 12 144 16 18 20 2 0 2 4 &6 § 10 12 14 16

New TCP Connection

16d.0

123.0

gz.0

1.0

Conns / Min

0.0 H H 2 H H H H
g 10 1z 14 16 15 20 22 0 2 4 o & 10 12 14 16

Established TCP Connections
20.0

15.0

10.0

Connections

5.0

0.0

8 10 12 14 16 48 20 2 o0 2z 4 & & 10 12 14 16

Server load average
280.0

219.0

1d0g .0

L

EBytes per Second

§ 10 12 14 16 18 20 22 o 2z 4 & & 10 12 14 16
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6.3 Service Status

Go to menu Status -> Service Status, This screen uses for display the status of the
service using in the IP-PBX whether it is running or not. You can turn the service on or off by
clicking on the start/stop button. And you can also set it to turn on automatically at every
booting time.

- SSH: Allow server to remote via secure shell

- NTP: Service to update the time from Internet time server

- WEB: Allow to do the configuration from website

- FIREWALL.: Service to enable the network security of this system

- IP-PBX: Service of telephony system

Service Skakus

Name Status On-Boot

55H - start | Stop * ves © No

NTP - Start | Stop ® ves T Mo

WEB - Start | Stop @ ves O No

FIREWALL fiffing _start | stop  yes o

IP-PEX, fiffing _start | stop * yes  hg
Apply

Metwark Tools

URL

Network Tools Seleck Tool @ ping -
__show status_|

We can do the network testing by ping, check DNS by nslookup and trace the router
hop from traceroute from the Network Tools part.

6.4 List DID Number
Go to menusStatus -> List DID Number, This screen uses for display the list of DID for
the digital telephony in the system.

List DID Number

Trunk DID Number Extension
gateway:sip:test_sys 202 nore
trunk:dahdi:test 343 none
trunk:dahdistest 208 none
trunk:dahdistest 555 none

Page 1:
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6.5 Phone’s Connection Status

Go to menusStatus -> Phone’s Connection Status, This screen uses for checking the
IP-Phone connection, PSTN connection, IAX connection, VoIP provider connectionto the
system separated in type and display the color labeledof each unit.

Phone's Connection Status

SIP

No Number Name (Callerid) IPaddress Natsupport VideoSupport Status Type
1 4000 -none- .no .no Unmonitored SIP
2 sipsite_wwaww -none- (@8 [ _ sIP
3 trunk%%sip%Yhasdf 0.0.83.97 [ = ®. Unmonitored sIP
4 3004 004 -none- [ @ UNKMOWN | sIP
5 3003 3003 -none- [ @ S -
& 3002 3002 -none- (@8 [ UNKNOWN | SR
7 =001 3001 -none- [ 9. GO s
8 3000 2000 -none- [ N @ o -
3 11w 1144 -none- D [ UNKNOWN | IR
0 1118 1119 -none- (@8 [ UNKNOWN | SR
11 1010 1010 -none- [ 9. GO =
12 1009 1009 192.166.0.190 [ ®. OK(EEms S
13 1008 1008 192.168.0.214 (@7 @ OK(103ms)  SIP
14 1007 1007 192.168.0.204 Dy @, oK(g5ms)  SIP
15 1008 1006 -none- [ 9. o -
16 1005 1005 -none- [ N @ NGO -
17 1004 1004 192.168.0.220 @ ( OKERmI s
18 1003 1003 -none- D [ . UNkMOWN | SR
19 1002 1002 -none- [ 1 9. GO s
20 1001 two 192.168.0.217 [ 1 [ Gk(Bms) S
21 1000 on Thousand 192.168.0.216 Oyes [ OK(105ms) 5P
IAX

No Number Name (Callerid) IPaddress Natsupport VideoSupport Status Type
1 server_qqqajuse (Unspecified) [l TN
2 g0 5000 (Unspecified) [
3 2000 Mr, TTwo Thoudsand (Unspecified) [ T
4 FaxD5P2/FaxDsr2 127.0.0.1 B Az
5 FaxD5P 1/FaxDsP1 127.0.0.1 E 1ax2
PSTN
No Number (Channel) Alarm Type

1 1 Mo Alarm FXO0
2 2 Mo Alarm FXO
3 3 Mo Alarm FXO0
4 4 Mo Alarm F¥0

5 5 Mo Alarm FXS

From the picture above, there are the colored labels at the status column. You
can identify from red colored whether it is not available and green color with the
response time whether it is available.
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Go to menusStatus -> Phone Status Panel, This screen uses for display the status of
every phone in the system from the color labeled.
Red— That phone is in use.

Blue— That phone is calling

Orange —That phone is ringing

Green— That phone is available.

Grey- That phone is not available
Brown— That phone is waiting from hold.

Phone Status Panel

SIP EXT
192, 168.0.124 4000 sipsite_wwwi trunk ¥ Yesip % Yeasdf
3004 3003 3002 001
3000 1144 1119 1010
® 1009 1008 @ 1007 1006
1005 1004 1003 1002
1001 1000
AGENT
200 201 101

Q Busy . Ring o Ringing D oriine Offline '. Off Hook

Go to menuStatus -> Active Call Status, This screen uses for monitor the phone call
in the system immediately (real-time). It displays the source, destination, application and
duration. You can click to hung-up or transfer the call from this page.

Active Call Status

We have total 1 active call Active Call
Source Destination Application Duration Command

(9]

1004 1003 Dial 00:00:06
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Chapter 7 System*‘s Sound Files (Manage the sound file)

7.1 Create Voice
This function uses to manage the sound prompt in the system. You can use this sound

prompt to be an IVR system. You can do it by go to menu Sounds -> Create Voice. The
screen will show as picture below.

Voice Prompt
[ View Voice prompt ] [ Create Voice Prompt ] [ Default Voice ] [ Clear All Record Dialplan ]

[ Filename

Description Th En [w | c2 Edit
Introduction to Plextel System Sound .
[~ Intro (Default) (4] 9% & pd
[ Goodbye Goodbye Sound (Default) (o] 9% (] I &
I Dialing Dialing Sound (Default) n @ v E] @X £
[ Invalid Invalid Sound (Default) a a v a ax £
[~ Nolnput MoInput Sound (Default) a a W m a k4 é
Page 1:
Delete Selected | Cancel |

From the picture above, you can add maximum 4 sound files for 4

languages.(There are 2 default sound file; Thai and English; in the system.)

Filename: Specify the filename

Description : Specify the description of this prompt
Listen: Click at Ellbutton to play the voice

Download: Click at&button to save the voice to machine
Edit: Click to change the voice of that prompt

‘Default Voice’ is the main voice which will play that language at the first

time. For example, you set English to be the default voice. It will play English voice
first. However, you can change it later.
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Voice Prompt
[ View Voice prompt ] [ Create Voice Prompt ] [ Default Voice ] [ Clear All Record Dialplan ]

Filename Description Th En a

ask_trunkpassword Ask Trunk password before dial out u @ W n @ ¥

channel_full Tell Dutgeing Channel is Full u a ¥ u E ks

L Used before dial out, if user input wrong

incorrect_password password (o] % 083

L, Used in IVR. when user input wrong

invalid_number number (o] % &3

N Used in phonelock feature when user input;

lock_invalid \wrong ... 4] [ EDEA «
Used in phonelock feature when phaone is

lock_nowlock locked 4] | EDEA «
Used in phonelock feature, ask user to

lock_select lock or unlock ﬂ @ 4 ﬂ @ ks
Used in phonelock feature, not allow to

lock_status ol out [+ % 08

lock_terminate Used in phonelock feature, when finish u @ v n @ ¥
lock menu

press Used to tell pressing status 83 (o] [

transferred_operator Transfered Operator n @ ' ﬂ E b
Used in phonelock feature when phaone is

now_unlock unlocked ﬂ@ 4 ﬂ@x

L . ; Used in IVR when dial to extension with

ivrdial-unavailable unavailable ﬂ g v ﬂ @ X

ivrdial-noanswer ;l;:vdvér: IVR. when dial to extension with no u @ v n @ ¥

from_IVR_userselect_novmDirect call from IVR with noanswer status u a L u @ %

from_IVR_userselect_vm  Direct call from IVR with voicemail u @ ' n E ks

menu_errar Direct call-wrong option u @ ' ﬂ @ ¥

roaming_select Used in roaming features n E ' n E ks

Page 1:

If we click on the edit button, the screen will show as picture below.

Voice Prompt
[ View Voice prompt ] [ Create Voice Prompt ] [ Default Voice ] [ Clear All Record Dialplan ]
Create Voice prompt

RRAERRE R ARRRE R R R R R RRRNE

Filename ntro

Introduction to Plextel System Sound (Default)

Description

Default sound Thai -
Thai Sound file
English Sound file

g |3
%

E F
88

Custom1 Sound file

g
3
1]
g

Custom2 Sound file

aprLy | cancel |

- Filename: Change the filename of this voice prompt

- Description: Change the description of this voice prompt
- Default Sound: Change the default voice

- Listen: Click at Elbutton to play the voice.
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- Record :Click at “** button to record the new voice from the phone.
You can upload the voice file to the system separately to each language by
clickingBrowse button at each field. Then click apply button to upload.

At the ‘Create Voice Prompt’ menu, The screen will show as picture below.

Voice Prompt
[ View Voice prompt ] [ Create Voice Prompt ] [ Default Voice ] [ Clear All Record Dialplan ]
Create Voice prompt

Filename
"
Description
Default sound Thai -
Thai Sound file Browse... |14

English Sound file Browse. .

111

|
|

Custom1 Sound file | Browse... |4
|

Custom2 Sound file Browse... |4

apPLY | cancel |

This screen shows that you have 2 waysto add the voice to the system.
1. Upload from your computer
2. Record from your phone

You can record the voice from your computer by using ‘Sound
Recorder’programat your computer. Go to Start -> Program File -> Accessory -
>Entertainment -> Sound Recorder

Programs » @ Accessories 4 @ Entertainment » @ Sound Recorder
) EditPlus 2 b5 Calculator volume Cantrol
y  Documents I Mera 3 1_j Paint (=) windows Media Player
I Startup I Communications ¥
Settings »
I Tennis Pro 3 ¥
) search » () The Weather Channel *
Microsoft Wword
) Help and Support t‘é] Outlook Express

¥

Run...

EEL ©0xXorTTe
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microphone.
@ Sound - Sound Re[:urder E]

File Edit Effects Help

Position: _ Length:
oovsec [ | 000+

I
After finished recording, you should click ‘File -> Save as’ and change some
properties of that voice by click atChange button as picture below.

Savein | () Sound File - £k B~

| yoicel.way
| yoiceZ, way
| yvoiced. way
ﬂ voiced, wawv

File name; | j Save

Save as ype: |5|:|un|:|s [Fwav] Cancel
Format; PCH 22,050 kHz, 16 Bit, Mono
Sound Selection
I arne;
|[untitled] j Save bs. . | |
Farmat: |F'Eh-1 j
Atributes:  |5.000 kHz, & Bit. Mono 7Tkbisec v
3.000 kHz. 8 Bit, Mono 7 kbizec e
3.000 kHz. 3 Bit, Stereo 15 kb/sec ]
000 kHz, 16 Bit. Mono 15 khfsec
3.000 kHz, 16 Bit, Steren 3 kbfzec L]
11.025 kHz. 8 Bit, Mono 10kbfgec |¥

At the ‘Sound Selection” window, you have to choose the format of this sound to be
‘PCM’ and Attributes is 8.000 KHz, 16 Bit, Mono as picture above. Then clickOK
and Save this file. You can bring this voice file to use with the system.
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Another method is recording from your phone. Go to menu Sounds -> Voice Prompt -

> Create Voice Prompt

Voice Prompt
[ View Voice prompt ] [ Create Vaoice Prampt ] [ Default Voice ] [ Disable Recording from Phone ]
Create Voice prompt

Filename
z
Description
Default sound Thai -
Thai Sound file [ Browse... |i&
English Sound file [ Browse... |
Custom1 Sound file [ Browse... | &
Custom2 Sound file [ Browse... |i&

MOTE: WAV file must be in Mano 16-bit 8KHz format™*

Cancel

You can record directly from yourtelephone by these following methods.
1. Specify the filename of this voice prompt
2. Click on the button on the right hand side of that language

e - .
Thai Sound file Lilsidanlnala

English Sound file Lilsidan il
Custom1 Sound file Lilsidanlldta =
Custom2 Sound file Lilsidanliata =

3. There is a pop-up window appeared. It will show the phone number for dial to
record the sound at ‘Recording Number’ and the time to stop and disconnect when
silent (represented in second). If you ready to record press Activate button.

il B’
& 192.168.0.124/libs/recorsdsound.ph... 5= (=l eS|

%) 192.168.0.124/libs/recorsdscund.phpHilename=&lang=

Recording Mumber 105

Silence Disconnect 2

[ Activate ] [ Done & Apply ]

*note: finish recording By press £, or silence for 2 seconds
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Now, you have to dial to that phone number as shown in the Recording
Number field. (Eg. 105) and talk to the phone. After finish, you can stop and silentfor
a 2 seconds (as shown in the Silence Disconnect) or press # to save.The system will
give ‘Beep’ sound to confirm. Then hung up and click at the iDone & Apply button

as picture below.
o !
B 192.168.0.124/libs/recorsdsound.ph... =] o =Ds e S|

) 192.168.0.124/libs/recorsdseund.php?

*¥| Ipdate completed

Recording Mumber 105

Silence Disconnect 2

Activate ] [ Done & Apply]

*note: finish recording by press #, or silence for 2 seconds

L |

7.2 Call Record Files

You can listen to the recorded voice call from every trunk (eg.Zap Channels andSip
Channels from this menu. Go to Sounds -> Call Record Files. The screen will show as picture
below.

Call Recording Files
Start date Belect Date End date Felect Date

FILTER NONE -

Display 1 - 21 from 21

[ Files Date Time Size isten  Download
[~ USR_OUT-from-1000-to-11@2010-06-25-14-47-48.gsm 010-06-25 14:47:48 1188 byte a 8
[~ USR_OUT-from-1000-to-11@20 10-06-25-14-48-17.gsm 2010-06-25 14:48:17 358 byte a Q
[~ USR_IN-from-1005-to-1006 @20 10-05-25-15-52-24.gsm 2010-06-25 15:52:24 36432 byte a B8
[~ AUTO-from-1005-to-1006 @2010-06-25-15-52-39.gsm 2010-06-25 15:52:39 3184 byte a @
[~ USR_IN-from-1006-to-1006 @20 10-06-25-15-57-17.gsm 2010-06-25 15:57:17 3300 byte a Q
[~ USR_IN-from-1006-to-1005@2010-05-25-16-45-02.gsm 2010-06-25 16:48:02 19041 byte a B8
[~ AUTO-from-1006-to-1005@2010-06-25-16-43-04,gsm 2010-06-25 16:43:04 13563 byte a 8
[~ USR_OUT-from-10038-to-11@2010-06-25-17-15-29.gsm 2010-06-25 17:15:29 12275 byte ﬂ Q
[~ USR_OUT-from-1009-to-11@2010-06-25-17-15-49,gsm 010-06-25 17:15:49 3960 byte a 8
[~ USR_OUT-from-1009-to-11@20 10-06-25-17-46-10.gsm 2010-06-25 17:46: 10 3415 byte a Q
[~ USR_IN-from-1008-to-1007@20 10-06-28-12-03-43.g5m 2010-06-28 12:03:43 4384 byte ﬂ Q
[~ USR_IN-from-1005-to-1001@20 10-08-25-13-24-56.gsm 2010-06-28 13:24:56 35993 byte a 8
[~ USR_IN-from-1007-to-1008 @20 10-06-28-13-30-24.gsm 2010-06-28 13:30:24 4917 byte a a
[~ USR_IN-from-1007-to-1008 @20 10-05-28-13-30-54.gsm 2010-06-28 13:30:54 25113 byte a 2]
[~ USR_IN-from-1008-to-1007@2010-05-28-13-31-36.gsm 2010-06-28 13:31:36 29865 byte a 8
[~ USR_IN-from-1000-to-1009 @20 10-06-28-15-42-37.gsm 2010-06-28 15:42:37 85239 byte a Q
[~ USR_IN-from-1000-to-1009 @20 10-05-28-15-43-42.gsm 2010-06-28 15:43:42 103356 byte a 8
[~ USR_IN-from-1007-to-1009 @20 10-05-28-15-44-33.gsm 2010-06-28 15:44:33 19074 byte a 8
[~ USR_IN-from-1004-to-1009 @20 10-06-23-09-25-50.gsm 2010-06-29 09:25:50 49467 byte ﬂ Q
[~ USR_IN-from-1004-to-1009 @20 10-05-23-03-31-04.gsm 2010-06-29 09:31:04 26895 byte a 8
[~ USR_IN-from-1009-to-1004@20 10-06-29-09-55-19.gsm 2010-06-29 09:55:19 9669 byte a Q

Page 1 A

Delete Selected I

Download Selected Copy to SMB

Move to SMB Cancel
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You can set the date range and condition from filter menu.

NONE : Select all

SIP Trunk : Select only the call recorded from SIP Trunk
ZAP Trunk: Select only the call recorded from ZAP Trunk (PSTN)
USER : Select only the call recorded of specific extension
QUEUE : Select only the call recorded in queue
CONFERENCE: Select only the call recorded from conference room

AGENT : Select only the call recorded from specific agent in queue

Then selectFROM, TO orBOTH and specify the number. And press select button, It

will appear the result as picture below.

Call Recording Files
Start date Eelect End date Eelect
FILTER  USER ~ BOTH ~ [1004

CHOOSE
Display 1 - 3{NONE

I~ Files SIP TRUNK
[ UsR_IN-F ZAP TRUMK

[ UsR_IN-fiQUEUE

™ usr_IN-AAUTO
CONFERENCE
AGENT

Delete Selected I

10-06-29-03-23-50.05m
2010-06-29-09-31-04.gsm
2010-06-29-09-55-19.gsm

Page 1

Download Selected Copy to SMB Move to SMB

Date Time

2010-05-29 09:28:50
2010-05-29 09:31:04
2010-06-29 09:55:19

Cancel

Call Recording Files
Start date Eelect End date Eelect
FILTER USER * BOTH ~ |1004 SELECT

Display 1 - 3 from 3
[ Files
[ USR_IN-from-1004-to-1009 @20 10-06-29-09-28-50.gsm
[ USR_IN-from-1004-to-1009@20 10-06-29-09-31-04.gsm
[~ USR_IN-from-1009-to-1004@20 10-06-29-09-55-19.gsm

Page 1 hd

Delete Selected I

Download Selected Copy to SMB Move to SMB

Date Time

2010-06-29 09:28: 50
2010-06-29 09:31:04
2010-06-29 09:55:19

Cancel

Size
49457 byte
26895 byte
9663 byte

Size
49467 byte
26895 byte
9669 byte

Listen Download
a [/}
a [/}
a [/}

Listen Download
a [/}

a [/}
a =2

You can set the voice to play during waiting the call. The voice file should be only
mp3 orwav only. Go to menuSounds -> Music On Hold, The screen will appear as picture

below.
Music On Hold

[ View Music-on-hold ] [ Add new Music-on-hold Group ] [ Upload Music ] [ Restart Service ]

Group Name : Default Random : yes ﬁ
[~ Voice Prompt Date Time Size Listen
[~ 55533.wav 23/06/2010 00:25 27944 byte @
I~ macroform-the_simplicity.wav 15/09/2005 02:39 4454220 byte @
[~ song.wav 25/06/2010 09:25 2913198 byte @

Page | 1

Delete Selected | Cancel |

Group Name : eng Random : yes é
I Voice Prompt Date Time Size Listen
[~ oh.wav 21/06/2010 11:51 3031963 byte a

Page | 1

Delete Selected | Cancel |
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You can create the group of music-on-hold by click at menu ‘Add new Musi¢-on-hold
Group’. The screen will show as picture below.

Music On Hold

[ View Music-on-hold ] [ Add new Music-on-hold Group ] [ Upload Music ] [ Restart Service ]
Add new Music-on-hold Group

Music-Group |

Random Yoo w

apPLY | cancel |

You can set the music-on-hold group separately to each group in the system
whether each group has their own sound (eg. music, announcement, etc.).

Music On Hold

[ view Music-on-haold ] [ Add new Music-on-hold Group ] [ Upload Music ] [ Restart Service ]
Upload recorded files

Select Group Default -

File to upload | Browse...

File I"lame|

Upload | Cancel |

After added new group, You should click ‘Upload Music ->Browse” and
select the file. You can change the filename by fill in the ‘File Name’ field. Then click
‘Upload’ button to upload to the system.

There are 2 choices to back up the voice record; Manual Backup and Schedule
Backup. Go to menu ‘Sounds -> Manual Backup or Schedule Backup’. These 2 choices have
similar methods.
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Backup Voice Record
=Hwarning: backup record files will take a lot of resources on the IP-PEX and it may
effect on the voice quality jperformance on the system, please do it after working hour=*

Backup Type copy -
Backup Location Local Harddisk -

Create Backup
Timer

From Day - [Select Date Create Mew Backup |

Create Badkup Timer |

From the picture above, these are the description of each fields.
Backup Type:Choose the backup method to CopyorMove (If you selected
Move, It will delete file out of the system. On the other hand, Copy method
willnot delete the file.)
Backup Location:Chosse the destination of backup file
Local Harddisk : Keep theBackup on thatServer, You can download that file
from the this page
USB Harddisk: Keep the file to externallUSB Harddisk (You have to setup the
External Storage to mount the USB Disk first)
SMB Drive: Keep the file to the SMB Drive (You have to setup the network
drive at External Storage first)
Create Backup Timer:Set the time schedule toBackup automatically
From:Specify the date and time periodBackup for filter the voice file

The picture below is the example of Backup Voice record.You can choose the date
from “From” then click “Create New Backup”. The backup file will be created and display at
“Last backups”. You can download to your computer by click on Download link of each
backup file.

Backup Voice Record

xxxxx

warning: backup record files will take a lot of resources on the IP-PEX and it may
effect on the voice quality /performance on the system, please do it after working hour=*

Backup Type copy -

es (Manage the sound file)

Backup Location |ocal Harddisk -
Create Backup

Timer Create Backup Timer

From Day ~ [2010-07-15 Create New Backup

Last backups

1283759009-2010-07-15.tar.az [ 06/09/2010 14:43 123 bvite 1 Download | Remaoved

Ch:



This is the example of schedule backup. You have to click “Create Backup Timer”. It
will display the popup screen as picture below. This screen allows you to specify the backup
time; eg. Everyday at 14:40.
= htlp:/J’lQE.168.0.124IIibsfcreatebackuptimer.php?t...l e

|§, http:--192.168.0.124-Iib5-crE.atEhackL|ptimE|‘.php?t'_-.'pE:ccpj.'&lccaticn:|

Schedule Backup

Create Backup Timer:
40 ~ 4 - = = F

@ Internet | Protected Mode: On

fa v HI100% -

[schedule backup] [backup now] [LOG]
Backup Location USE Harddisk -

Status OFF -

backupevery 00 » 15 = 31 =

Backup type  full backup
File older than  day -
Compress yes -

APPLY | resetl

- ||[F + help

Backup Location:Chosse the destination of backup file

USB Harddisk: Keep the file to externalUSB Harddisk (You have to setup the
External Storage to mount the USB Disk first)

SMB Drive: Keep the file to the SMB Drive (You have to setup the network
drive at External Storage first)
Status:Select to enable or disable
Backup every:Specify the date and time toBackup. You can go to help menu
for example as the picture below.
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Schedule bai hi

set date of the  set month of the set day of week

set minute from  set hour from 00 month from 01  year January toSunday to

00 to 59 to 23

to 31 December Saturday
Example
Exccuon time
backup every [oo =] [z <[ =] [ B 2| 02:00 am of every day
backup every [o0 =] [157] [10=] [+ KIE =1 03:00 pm on the 10th of every month
backup every |30 x| |18 x| [15 7| |February | | =] 06:30 pm on the 15th in February
backup every [30 x| |* =||* = |Juy | |Monday =] every hour at mimte = 30 on every Monday in July

- Backup type:Choose the method toBackup
full backup — Backup all files
increment backup -Backup only the new file which never backup in the past
move - Backup the files and delete those files in the system
- File older than -Backup only the older than selected day.
- CompressEnable the compression for backup file. It will represent in zip file.
- backup nowClick to createBackup file from the specified backup properties

After finished setup the external storage, you can go back to voice record
backup, select the destination andclick the backup button. It will display the popup
screen as the picture below. This screen will show the status eg. Filename,
quantity of the files, size, location, etc.

& hitp://192.168.0.124/modules/schedule_backup/sbackup.php - Windﬂwsln...l =HAC ﬂ_h,l

| £ | http://192.168.0.124/modules/schedule_backup/sbackup.php |

-

Start copy

/tmp/backup_2010-09-06-16-14-16.zipcopy 191 files and compress
2010-09-06 16:14:16 Copy Full Backup and Compress 191 file
Complete/var/www/html'modules/schedule_backup/log/log txt

& Internet | Protected Mode: On dy v ®100%

7.4 External Storage

This menu uses for setup the external HardDisk Drive for keeping voiceBackup (eg.
USB Flash drive, USB External Harddisk and Network shared drive).There are 2 types.

1. SMB Network Drive

You can backup and store the files to the network shared drive by setup the drive at
the Plextel IP-PBX first. Go to menu Advanced -> External Storage ->choose “SMB
Network Drive”
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External Storage
[ SME Metwork Drive ] [USE Harddisk Mount ]
SMB Network Drive

Checdk Current Mount refresh
Server IP address | J J J List Server
Mount at boot Yes -
Reguired Authentication No -
Username Password

Shared Name == | List Shared
Local Mount-Name Jmnt/smb

APPLY

Click at°List Server’button to find the Computer which sharing theDrive on the
network. It will display the pop-up window and list the name of shared drive’s computer.
Click on the “List Shared”. It will display the pop-up window to specify the destination
folder. Then click APPLY button to finish.

External Storage

[ SMB Metwork Drive ] [ USE Harddisk Mount ]

SMB Network Drive
//192.168.0.25/temp on /mnt/smb type cifs
Check Current Mount ] refresh
Server IP address [192 fis2 o J25 List Server
Mount at boot Yeg w*
Required Authentication Mo -
Username Password
Shared Mame == ftemp List Shared
Local Mount-Name Jmnt/smb
APPLY

This is the method to setup theExternal HDD Drive to use with the backup system on
Plextel IP-PBX. Go to menuAdvanced -> External Storage -> choose “USB Harddisk Drive”

External Storage

[ 5MB Metwork Drive ] [ USE Harddisk Mount ]
USB Harddisk Mount

*external harddisk must be format as FAT32
Current Mount

Harddisk device Select Device -
Partition
Detect harddisk | Mount harddisk | |

Plug-in the USB Storage device (eg. USB Flashdrive or USB External Harddisk),
ClickDetect harddisk, selectHarddisk device and Partition then clickMount harddisk to mount
that device to the system.

External Storage
[ SMB MNetwark Drive ] [ USB Harddisk Mount ]

USB Harddisk Mount
“external harddisk must be format as FAT32
Current Mount

Harddisk device Disk /dev/sdb: 255 MB, 255327744 bytes -
Partition fdevfsdbl 1 31 248976 6 FAT16 -
Detect harddisk | Mount harddisk | |
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After click ‘Mount harddisk’. I will display as picture below.

External Storage

[ SMB Metwork Drive ] [ USBE Harddisk Mount ]
USB Harddisk Mount

*gxternal harddisk must be format as FAT32

Current Mount fdev/sdbl on fext_hdd type vfat (rw,uid=5080,gid=5060)
Harddisk device Select Device -
Partition

Detect harddisk | | Umount harddisk |

You can see the status of bothSMB andUSB Drive at Status -> System Status. It will
display as picture below.

System Current time : Mon Sep 6 14:25:01 ICT 2010

UP Time : 14:25:01 up 11:23, 1 user, load average: 0,00, 0,00, 0.00
LAN IP Address : 192,1658.0.124

WAN IP Address :

Metwork Usage

Device Received Sent ErrfDrop
lo 5.24 MB 5.24 MB 0/0
etho 1546 MB 47 .67 MB 0/0
wlgl 312,75 MB 312,75 MB 0/0
sit0 0.00 KB 0.00 KB 0/0

Memory Usage

Type Percent Capacity Free Used Size

Physical Memory 53% 173.99 MB g20.46 MB 994 .45 MB

- Kernel + applications 2% 237.70 MB

- Buffers 15% 153.73 MB

- Cached 43%, 429,03 MB

Disk Swap 2 e 2.00 GB 0.00 KB 2,00 GB

Mounted Filesysterns

Mount Type Partition Percent Capacity Free Used size

& extd  fdev/sdaz 11% (1%) 23.78 GB 3.13 GB 28,38 Gb

fwar extd /dev/sdaS = 3w (1) 104,90 GB 3.0 GB 113,78 GB

/boot ext3 /dev/sdal T sa (1) 258.08MB  15.65 MB  288.63 MB

Sdew/shm trnpfs trnpfs ) 0% (1%) 497,23 MB 0.00 KB 497,23 MB

Svar/spool/asterisk/monitor  extz /dew/ram0 BT 33.04 ME 1.51 ME 94,56 MB

Smntfsmb cifs  //192.168.0.25/4emp 78% (1% 304.40 GB 1089.69 GB 1394.10 GB ||

Jext_hdd wat  /dev/sdbl 2 oo 242,54 MB 360,00 KB 242,09 MB
Totals . L 434,15 GB 1095.05 GB 1537.35 GB |
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Chapter 8 Call Center

How to CreateCall Center orQueue

Before start using Call Center feature in the PEXTEL IP-PBX system, You should
design the flow of call. Eg.Set the incoming call and IVR, Type of call distribution.

Type of queue.
1. Agents login permanently and wait for the call with their headset until the call has
come. Agents will listen to the music-on-hold all the time.

2. Agents can login/off by their phone. If there is any call to the call center system, It
will ring at their phone.

How to create call-center agent
Go to menuCall Features >> Agents >> Create Agents

Agents Manager
[ View Agent] [ Create Agents ] [ Advanced Config ]
Add Agent

Agent ID |
Agent Admin Password |

Agent Name |
Agent Group Number |

APPLY |

Agent ID: Number to identifyagentfor logging into the system.

Agent Admin Password:Password forlogging into the system.

Agent Name: Specify theagent’s name. (Optional)

Agent Group Number: Specify the group number ofagent.
Then clickAPPLY to createagent



How to createQueue
Go to menu Call Features >> Queue >> Create Queue

Queue Manager
[ View Queue ] [ Create Queue ]

Add Queue

Queue Name l—
Announce None ~
queue-thereare None v
queue-callswaiting None v
queue-holdtime None v
queue-seconds None v
queue-youarenext None v
queue-thankyou None v
Allow direct call From this queue no -

Music On-Hold Default ~
Ring Strategy ringall -
Auto Pause Agent ? no -«

Service Level Statistics {(sec) ? V—

Agent Ring Timeout (sec) ? ’15—

Enable Ring Timeout Reset **BETA®* ? no -

Enable Ring when SIP Agent in “INUSE" state ? no -

Retry all agents ring wait time (sec) ? 15
Queue Weight (higher the better) 5
Agent Rest Time (sec) ? 5

Maximum Queue Size (0-infinity)

Report Hold time to Agent ? no -

Announce Queue Information Every (sec) r

Announce Estimate Hold Time To Caller once -

Recording Format gsm v

Allow user to enter queue when no AGENT * ves " No " Strict
Remove Caller from queue when no AGENT " Yes ™ No

Agent Members (Add Multiple)

Select Agent Members None

Add Agents |

Queue Name: Specify the Queue name

Announce: Play the sound prompt before coming to the queue

Allow direct call from this queue:Enable to allow dialing to specific extension from
user’s dial pad while waiting the call. (This menu has to setup to ‘Incoming call’ and
‘Call control’ first.)
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Music On-Hold: Specify the sound prompt to be the music-on-hold while waiting the
call in the Queue

Ring Strategy: Type of call distribution to agents.
Ringall : Ring every active agents at the same time.

Roundrobin: Ring each agent as loop.
Leastrecent: Ring the agent who has longest free-from-receive period first.
Fewest calls: Ring the agent who has fewest received the callfirst.
Random: Ring randomly.
Rrmemory: Ring as loop and remember the last position of agent then go
ahead.
Auto Pause Agent:Pause Agent automatically if he doesn’t answer the call in time.
Agent Ring Timeout: Set the expire time for ringing
Enable Ring when SIP Agent in “INUSE” state: Allow call waiting during call
Retry all agent ring wait time:Set the time for waiting until skip to other agent.
Agent Rest Time: Set a break time foragent in case that agent receives too many
calls. (Specify in second)
Maximum Queue Size (0-infinity): Set the maximum incoming call to this queue in
the same time
Report Hold time to Agent:Enable system to say number of waiting call in the queue
Announce Queue Information Every (sec): Enable system to say information of the
queue every minute during waiting call.
Announce Estimate Hold Time To Caller: Enable to tell the estimate time for
waiting the call for people who waiting in the queue
Recording Format: Set the file format of voice recording

Allow user to enter queue when no AGENT: Enable incoming call to the queue
incase the agent has not logged in.

Remove Caller from queue when no AGENT:Enable to decline every call in the
queue in case every agent logged out.

Agent Members (Add Multiple): Add member or agent to this queue. Agents can be
3 types.

Type of agents

1. Specific SIP extension: This type suits for the system which has not too much agent in the
system.

2. Agent login: This type suits for the system which has too much agent in the system. Agents
have not to sit at their phone permanently. Agents can login/off by their phone.

3. External line: Agent can be the people who are not sit in the office (may be mobile phone
or other sites)

To setup priority of agent is the easy way to manage the skill of agent who has their specific
skill (eg. Language or performance of that agent)
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Go to menuReport >> Realtime Agent Status

Agent Status

Manual Agent CallBack Login

Select Agent: 102 ¥ Select Extension : 9009 + Ackcall : false v WrapupTime: [5 login

Agent Talk call Last State Last
Queue Agent Narc LoginChannel Status o Penalty Takiin (se0) Call LoggedlnTlmePaused..u.

_-__----_-_- 2l
[Queue_SIP Notinuse - 00:00:00 - e waE )
Queue_Agent Agent/102 John nfa Unavailable n/a 1 1 55 secs 13:42:48 00:00:00 NO W
Queue_Agent Agent/101 Peter nfa Unavailable nfa 1 0 0secs 00:00:00 00:00:00 NO wuue

& Busy/Paused Inuse Ringing @ Notin use Unavailable,Invalid

From the picture above, there are 2 queues using in this system.

Queue_Agent has 2 members (101 and 102) and Status isUnavailable. The status tab
shows in grey colored. It means that agent has not logged in to this queue.
Queue_SIP has 2 members (9008 and 9009). We have not use agent with this queue.
But we fix the extension to this queue.The green colored tab shows online status of
that extension and ready to receive a call. If the tab shows red colored, it means
unavailable.

Administrator can do ‘Manual Agent CallBack Login’ for the agent at this page by
selecting agent number and extension number. Then click ‘login’ button.

Login Channel: shows the extension number that agent logged in (only agent login
type)
Status: There are 4 types of status.

= Not in use (green colored)

= Inuse (or Busy)

= Take To : shows talking agent number

= Priority : shows the importance of this call
Call Taken: amount of incoming call (It will be resetto be zero when reloaded)
Last State (sec) :free time gap from last call (start with 1 when hung-up)
Last Call: Call duration of last call

LoggedInTime : Last agent login time(Only agent login, not include SIP

agent)
Pause: You can do ‘Pause’ when you would like to avoid receive the call no matter
you are logged in until you do ‘unpause’. There are 2 ways to do.
1. Agents pause his number by himself. (See how to press the dial pad at menu
Call Features>>Feature Code/System Setup )
2. Pause from web interface (individual agent pause)
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Wiy o
W o

Pause all agent from each queue

UnPause: cancel pause individual agent

UnPause All: cancel pause agent frome ach queue
Logoff : click to Logoff that agent

o ok~ w

At menuReport >> Realtime Queue Status

This screen shows the real time status of queue. You can selected the queue
from dropdown box above.
Queue Summaryshows basicstatus of theQueue
Queue Detailsshows agentstatus of theQueue (both logged-in and not logged-in)

Queue Status
[Queue Summary] [Queue Details] [Selected Queue Details]

Select Queues: Queue_Agent v

Queue Name : Queue_Agent

Call Limits  Waiting Calls Avaﬁﬁlgold Call Complete Abandoned Call Ring Strategy Service Level Servi;:rlf_evel Weigl
0 1 17 0 0 leastrecent 0 0.0 0
Queue Members
Name Agent Name  LoginChannel = Membership Penalty Calls Taken Lastcall Status Paused
[ Agentfibz || John  SPj90090000000e | stafic [ & [ 0 ([om0m00 |[ Esy [ NO |
Agent/101 Peter nfa static 1 0 00:00:00  Unavailable NO
Current Waiting Calls
Position Channel CallerID CallerIDNAME ~ Waiting Time
1 SIP/9008-0000000d 9008 9008 00:01:17
. Busy/Paused U Inuse Ringing @ Not in use ' Unavailable, Invalid
Inbound Queue Report
[ iew ] [ Setting ]
Start date [Em-og-m End date Iﬁlﬂ—ﬂg—ls
Select Queue Queue_SIP *  View
Queue Mame Queue_SIP CONMECT 1
Total Incoming Calls 1
Bangkok 0 ABANDOM
Mobile O EXIT
Others 1
genttumber  Total Receve Callrom Quewe | ol TranferCall | nernal rasfer | External Tranter
SIF /3007 1 1 1
SIP/9003

List of "Internal & External Transferred To" extensions
Extensions Total

DAHDL/3 1

Internal Tranfer External Tranfer
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At menu Report >> Queue Statistic Report
This menu uses for display the statistic of incoming call toeach queue. You can filter
the time for each period. It can report as monthly, daily and display in graph for each agents.

Queue Statistic Report
Show: Days ~ Date |[2010-09-13 End Date [2010-09-15 Select Queue : Queue_Agent - View

Start time :2010-09-13
End time :2010-09-16

Type :Days
Queue name : Queuve_Agent
Agent Queuwe name Mon 2010-09-13 Tue 2010-09-14 Wed 21
Agentf101 Queue_Agent o o 1
Agent/102 Queue_Agent o o 1
ABANDOM Queue_Agent i i a
TOTAL Queue_Agent [u] [u] 2
2018-89-13 to 2818-89-16
1.0 j —
0.5
L
L
0.z -
L 1 |
el N ] o
QS}Q \Qfg ngj @f@
NN It f@\ It
= 2t
af < & <8

This feature uses for evaluate the quality of service of agents. The concept of this
feature, Agents have to transfer a customer’s call to this feature. It will play the sound to
advice customer to give the score in range. After customer press number, the system will play
goodbye sound and hung-up.

Go to menu Report > Customer Satisfaction Report > Setup. The screen will show
as picture below.

Customer Satisfaction Report
[ Summary ] [ Details ]

Score Range: 5 F.pph.rl
Clean All Data: Clean All Data

From the picture above, we can set the score range (eg. 1-5 or 1-9)
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Next, Goto menu Call Feature - Customer Satisfaction Report Setup, The screen will
show as picture below.

Customer Satisfaction Report Setup

Customer Satisfaction Report Setup

Mumber EEE]
Gresting Sound Intro -
Goodbye Sound Goodbye -
Confirmation Sound Dialing -
Languags th -
Required Confirmation * ves U No
Repest this menu for NO-input (times) 2
*note® onhy biind transfer is supported

APPLY

Number:Specify the number to use with this system. (Beware of duplication with
extension or call-feature)

Greeting Sound: Select the greeting sound prompt to use with this system. (Eg.
“Please give the score for this service. Excellent press 1. Good press 2.....)However,
you can create the sound prompt at topic 7.1 Create Voice

Goodbye Sound: Select goodbye sound prompt to play after press button. (Eg.”
Thank for participation, Thank you”)

Confirmation Sound: Select sound prompt for confirmation (Eg. “You choose 5.
Press 1 to confirm”)

Language: Choose the language (It will choose at sound prompt)

Required Confirmation: Enable to use confirmation for each selection.

Repeat this menu for NO-input (times):Specify the repeat time whether customer
has not press the button in time.

After we set up this feature, You can see the score statistic of each agent by go to

menu Report = Customer Satisfaction Report = Detail. The score will show in GPA.
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CHAPTER 9 VirtualFAX System

This chapter will describe about the fax system in the Plextel IP-PBX. The fax
feature in the Plextel IP-PBX uses virtual fax technology. You can send, receive,
backup, forward and manage easily from web-interface in the PDF format.

9.1 Add virtual fax
You have to setup the virtual fax machine in the system first. Go to menu

FAX>add virtual fax
_ @ ) Virtual FAX
P lextel SyStem' 5 [Edit virtual FAX Device] [Add virtual FAX Device] Fax Status]
. Fax Fax group Fax phone Local Mumber of ring before Fax Default fax email )
5'.10;'::1 | Close Al r name name number Nmnﬁﬁer answer type address Edit

- us
R Page Delete Selected 2
<" Report

Group Manager
Extensions
call Ccntr‘r 1
> Call Features
> Sounds
Incoming Call
Outgoing Call
Schedules
VR
Site to Site Setup
Manual Config

Voice Interface
Log
> Advanced

Click at ‘Add virtual FAX Device’, the screen will show as picture below.
Virtual FAX Device Setup

[Edit virtual FAX Device] [Add virtual FAX Device] [Fax Status]
Fax Properties

0. Fax name Fax_test

1, Fax Group Mame e

(for Outgoing FAX) new v jntema Add

2. Fax Phone Mumber |1[]D‘3

3. Local Identifier E

(Company Mame) bmse

4, Mumber of Rings before answer 1 -

5. Fax Type internal -

7. Forward fax to Intemal Users v w0z M 1003 (Wiwos [ soor [ wos [ 3000 [ 3001

[ 3002 [ 3003 I 3004 [ wor [ wos [ oooe [ coos

[ o007 [ soos I ooos [ googa [ ooo3 [ ooo2

N



Fax name:Specify the name of this virtual fax device.

Fax Group Name (for Outgoing FAX):Select the user group of this fax deviee.
However, you have to create the group at the first time by select new in the dropdown
box and specify the group name.

1. Fax Group Mame
(for Qutgoing FAX)

new -+ jnternal Add
Then click add, the new group name will be added to the dropdown box. So, you have
to select it again.

1. Fax Group Mame
(for Qutgoing FAX)

internal * del
FAX phone number:Specify the phone number of this virtual fax device
Local Identifier (company name):Specify the company name
Number of ring before answer: Select the number of ring time for receive the fax
Fax Type:Select the fax type

Internal: This is the virtual fax device using in within the system.

External: This is the virtual fax device using with other system. Eg.Sending
fax outside by PSTN or VoIP.

In case of selected External fax, It will appear the textbox to enter default fax email
address.

5. Fax Type external -

Fax Routing

6. Default Fax email address |

orwards fax to internal users: Select the extension to forward the fax whenever
the system received the fax.

After finished setup virtual fax device, click at view virtual fax. You will see
the detail of that virtual fax device. (normally, it will show ‘running and idle”)

Virtual FAX Device Setup

[Edit virtual FAX Device] [Add virtual FAX Device] [Fax Status]

Fax group Fax phone Local Mumber of ring before Default fax email )
[ Faxname name number identifier answer R address Edit
[ Fax_test:? external 1008 poise 1 external f

-

Pagel: Delete Selected

You can see the real-time status of the fax by click at ‘Fax Status’
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Virtual FAX Device Setup

[Edit wirtual FAX Device] [Add virtual FAX Device] [Fax Status]

Fax Status
Modem Status
test_internal (1009): Running and idle
Fax_test (1008): Running and idle
1D User File Destination Page Dials TT5 Status [x]

In case of using internal fax, you have to know the fax prefix of that number by go to
menu call features>feature codes.

Features Code [ System Setup
Call Center Code
Agent Login (permanent) = - F
Agent Calback Automatic e T
LognLogoff N
Agent CalBack Logn =~ [0
Apent CalBack Logoff = v R
Pause Agent Prefix . T ﬁl
UnPause Agent Prefix - F&J
Transfer to Agent Prefix |4_"|
Whisper * - k7
Private Whisper bl ﬁ
Channel Spy = - E ngrd:lﬂy
Call Parking
Parking Mumber 700
Parking Pasition [Fo1 -
Max Parking Time 120
Transfer digit tmeout E
Features Key Mapping
Features dgit tmeout{ms) ﬁ
Call Pidap * - F
Extensians Pidwp 5 F
Blind Transfer E |1
Attend Transfer B YE
Disconnect - TF
One Touch Record - 'E
Voicemall 100
Phone Lock E
Roaming Staton Register /i =, "
Dt Prefix
|Fax Prefix - E] |
Features Key Mapping
CUSTOML = - Enable ™
ey | concel |
Restare Default

You would like to send fax to number 1003 and fax prefix is ‘33’. You have to press
‘331003’ to get fax to of 1003)
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In case of using external fax, you have to set the outgoing call first. And
change the call control to enable sending out.

Call Control
‘ :
R
h 5
Group Hame #_Eﬁl :j = .
A E A S
! ggggﬂ%gﬁﬂgﬁag
an ce 2 bes el
BIX g T35 8838883
FIFIFICICICIFIC|ICIFIFITCIFITIErErr
FIMIMIT T T MWV T
FIFIMITCCICIFICICIFIFIFFMFITCT e
test_site e e e e e e e e e e e
xxx(SIP) il e et e e e e e e R e
dsdsd(SIF) ol ] e et e e e e e e e R e
113 iy i e e e e
main e e e e e e e e e e e
20Quewe . = e e e e r
= rgEitttttzztttt
e LI =L L L L L o
programmer Nl o i A R R

Page 1: APPLY |

PEstensions Group  Outgoing Call Call Features  Site-to-Site [ Queue | IVR FAX

From the picture above, you have to change the permission of external fax
(identified in yellow tab)to allow call out via PSTN.

Internal user who would like to use fax, they have to enable the fax mailbox
by go to menu extension and click edit that extension.
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Plextel Svstem: @ Extension Manager
extel system ks [ view Extensions ] [ Add SIP Extension ] [ Add Multiple SIP ] [ Add IAX Extension ] [ Add Analog Extension ] [View All,Add Follow-Me Extension]

Show All | Close All
Y —— Display 1 - 30 From 30 Extension Import Browse... Data Import | Extension Export
20 A
» Report

Page 1 ¥
Group Manager 3=

" Number TypeGroup Pickup Call From  BLFI/RO/RINTLang AP "Th‘:’p“: DIDFollowmeRoaming  User Email \hnailm:
Fax k r ]{agﬂs:al;; sip  Default:Default:Default v v x Thai x  mone - M nicrora@hotmail.com
«Call Control [~ 1001:twosip Dafault:Dafault:Dehultg;f;ei:;[;ﬁfzitg;fu\t S/ o % Thai + snom3E0 v M email@company.com " v | &
= T [ 1002: sip  Default:Default:DefaultDefault:Default:Default v Th - W ﬁ
Conference 1002 poise:eng: test1234 x Thai x none X
[T 1003: sip DefaultDefault:DefaultDefault:Default:Default . - v v
;e:-‘mres Code { System 1003 poisezeng: test1234 v « x Thai x none x
etup . ; ; . -
= r }Egj sip  Default:Default:Default ¥ o % Thal x snom300 M v

b

Go to ‘enable the fax mailbox’ and change to ‘Yes

Fax Mailbox

Enable Fax Mailbox : Yes -

Send Fax Message Motification To Email : Yeg - R
Attached Fax File To Motification Email : Yes

Send Voicemail Motification For Incoming Fax : Yes -

Fax Mailbox Size : 20 -
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To send fax, you can do it by logged in to system and go to menu ‘Message

Center>FAX’

PLEXTEL

S Y S T EM

Home | Phone Books |

&

Plextel System:

Show Al | Close Al
=" Status
Show Status

System Statistic
Power Management
Service Status

List DID Mumber

Phone's Connection
Status

Phone Status Panel
Active Call Status
> Report
Group Manager
Extensions
Fax
Call Control

** Call Features
Conference

Features Code [ System
Setup

Paging

Mew Features
Mew Macro
Agents

Queue

CallerID Routing

Customer Satisfaction
Setup

Virtual Number

* Sounds
Incoming Call
Outgoing Call
Schedules
IVR
Site to Site Setup

¥ Manual Config

 Voice Interface
Log

= Advanced

PE¥ Advanced Setting

Metwork Setting
Manage Admin

Sereen pop-up Account
HA Setup

S5H Terminal

You can see the detail of fax pages at this page and also download to your machine or

Call Details Record |

Message Center

| CRM | Logout

1

Message Center

[ Voicemail ] [ Call Record ]

[ ™ Fax][®])send fax][ & F 5 2

* Start Date: End Date : SEARCH

Sender(TSID) : All
Delete Selected

Page 1:
[~ Type Device

[~ Outgoing test_internal test_page_03957-from-

[~ Internal

[~ Internal

[~ Internal

[~ Internal

Filename [ Status

55555, pdf

Date

2010-
07-01

status::No local disftone; too 14:36:39

many attempls to dial <333

hahaha_gv04Z-from-

2010-

55555_6LQ91_SOWULpdf 06-28

fax000000041-from-
1234567890_RY0BEG.pdf

hahaha_gW04Z -from-
55555_6LQ91.pdf

fax000000046-from-
1234567890_1CEYR.pdf

[T Internal test internal fax000000046-from-

1234567390, pdf

[~ Internal test_internal fax000000045-from-

1234567390.pdf

[~ Outgoing test_internal wd_PS4YG-from-

[~ Outgoing Fax_test

55555, pdf

13:41:48
2010-
06-28
13:41:46
2010-
06-28
13:40:23
2010-
06-28
13:39:24
2010-
06-25
15:13:55
2010-
06-25
15:11:51
2010-
06-25

status::No loca! disftons: too 15:04:48

many attempls to dial <333

hahaha_&v04Z-from-
55555, pdf
status: :Complete <0

[~ Outgoing test_internal test ES3VY-from-

[~ Incoming Fax_test

[~ Incoming Fax_test

55555, pdf

2010-
06-25
14:55:54.
2010-
06-25

status::**** \Wamning<347> 14:53:26
[~ Outgoing test_internal test_03EST-from-

55555, pdf

2010~
06-25

status::**** Warning<347> 14:52:54

fax000000042-from-

1234567890_6R 5KH.pdf

fax000000042-from-
1234567890_21U1T.pdf

[~ Internal test internal fax000000041-from-

1234567390, pdf

[~ Internal test_internal fax000000027-from-

[~ Outgoing Al
[~ Outgoing Al

[~ Qutgoing All

Delete Selected

Page 1:

1234567890.pdf

2223 _D74KH-from-
55555.pdf
status::Unknow=s
2223 _D74KH-from-
55555.pdf
status::Unknows=>
2223_D74KH-from-
55555.pdf

status::Unknow==

forward that page to other user (also outside)

2010-
06-25
14:51:12
2010-
06-25
14:51:12
2010-
06-25
11:51:18
2010-
06-24
16:39:56
2010-
06-23
04:40:38
2010-
06-23
04:40:34
2010-
06-23
04:40:30

From

(CallerID)

55555

1006

55555

55555

55555

unknown

unknown

55555

55555

55555

55555

unknown

unknown

1009

1009

55555

55555

35333

Sender
(TSID)
Admin

Admin

1234567890

Admin

1234567890

1234567890

1234567890

Admin

Admin

Admin

Admin

1234567890

1234567390

1234567890

1234567890

Admin

Admin

Admin

To

15

1005

1006

1006

1006

1007

1001

1005

11

11

11

Admin

1002

1002

1000

77

656

555

Size Download View Foword

(Kb)
3.24

329

3.29

27.06

27.52

3.24

3.24

3101

3101

26.74

27.41

230.8

230.8

230.8

<]

T << < < < I < I < T < I <

>

.

/)

2 0B 0B B B B B @ @B B
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To send fax by virtual fax device, you can go to menu ‘Send fax’. The screen will
show as picture below.

Message Center
[ Voicemail ] [ Call Recard ] [Fax ] [ SMS ]

[ ™ Fax] [#®Jsend fax] [ & Fax status]

Sending fax
Select file to fax : s\Usersintaniads\Documer  Browse...
|C Q Upload
MNew file name (English Only) : hanual
Upload file Preview Del
Destination fax number : 12 !
Fax device : Fax_test::tylAX2 -
Use cover page : no -
Priority : normal 127 -
Retries (times) : 1 -
Resolution : normal -
SEND | CAMCEL

Select file fax:Browse the file from your computer (only in PDF format)

New file name(English Only): Specify the filename (only in English)

After that, you have to click upload button and wait until the table show the filename
of that document.

Select file to fax C:\Users\intania85\Documer  Browse... |
Mew file name (English Only) : f‘nanual

Upload file Preview Del
manual_435TP.pdf Preview Del

Destination Fax Number:Specify the phone number of destination (you have to put
some prefix or dial-pattern here)

Fax Device:Select virtual fax device

User cover page: Enable to use fax cover. If you selected ‘yes’, it will appear some
form to edit fax cover as picture below.

|Jse cover page : yes -

To:

Compary

From{CallerID] :

|
|
|
Subject : |
Mate ‘
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Priority:Select the level of importance of this fax. There are 4 levels; Junk / Low /
Normal / High. Normally, We use normal level.

Retries (times):Number of retry time whether it occurs error.

Resolution:Select the resolution of document.

During sending fax, you can see the real-time status of that fax by go to menu ‘Fax
status’. It will open a pop-up window as picture below.

Fax status

L LJS“i’ou can forward the fax6 other recelver by go to %Pé‘ﬁii’“'forwaf&geand %@Fectﬁﬁ% Sa
43 Admi 3RDVQ-from:5 53059 [x1
extension (recelver7 then click orward button.

Forward fax to Internal Users

1001 1002 1003 1006 9001
1009 3000 3001 3002 3003
3004 1007 1005 9009 9003
9007 9008 9005 9004 9003
9002
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Chapter 10 CallerID Routing & Call Back

is the menu to manage the incoming call to any destination.
This feature will detect the Caller-ID whether it matched to the condition. You can set the
condition by go to menuCall Features >> CallerID Routing.

CallerID Routing

[ view Routing Rules ] [ Add Mew Rules ] [ Default Rule ]

Rule Name : default éf

AF‘F‘LYI Cancel |

First, you have to createnew rue by click at ‘Add new rule’ and specify the rule
name.From the picture below, we specify the rule name to be‘test CID’. The destination is

extension 1000. That means, this rule will be route to extension number 1001. Then click
apply button.

CallerID Routing

[ view Routing Rules ] [ Add Mew Rules ] [ Default Rule ]

Add New Rules

Group Name ftest_CID

Rules Name ftest_CID

Destination Extension hd

Value SIP/1000 =

APPLY Cancel
After click finish, the screen will show as picture below.

Group Name : test_CID
Rule Name : test_CID &
Destination: extension :: 1000

Datalmport CallerID Routing Export

Ho. CallerID Hote Edit Delete
[Aadd Mew CallerID]

APPLY Cancel

Then specify the CallerID number to this rule by click‘Add New CallerID’.

Group Name : test_CID

Rule Name : test_CID &
Destination: extension = 1000

Datalmport CallerID Routina Export |
No. CallerID Note Edit Delete
1 025558598  poise &
| 126568597 poise add | cancel
[Add Mew CallerID]

APPLY Cancel



You can specify the CallerID and click Add button to add number into system.when
finished, you have to click Apply button. The screen will show as picture below.

After finished these settings, the incoming call; which CallerID matched to the
settings; will be route to the specified destination (Extension 1000).

You can apply this feature for the agent who is the steady customer. He will have the
hotline to this agent.

CallerID Routing

[ Wiew Routing Rules ] [ Add Mew Rules ] [ Default Rule ]
Rule Name : default &

Group Name : test CID

Rule Name : test_CID &
Destination: extension :: 1000

Datalmoort CallerID Routing Export
Neo. CallerID Note Edit Delete
1 0265568598  paise &
2 0265568597  paise &
[Add New CallerID]
APPLY Cancel
Then configurelncoming Call
Incoming Call
[ View Incoming Call ] [ Add Mew Incoming Call ]
Add Incoming Call
Trunk trunk:dahdi:test * [ paBXdink
Description |
Support DID ng -

Replace CallerID |

Extensions Ring Timeout({sec) 40 -
Enable CallerID-Based Routing Service test CIDD -

Add time based handler |
Actions

When * Working_Time - Destination™ | ;. -

Value THILLEE -

Remave
Cancel

From the picture above, Every incoming call will check the rule from CallerID
Routing. If it matched to any rule, It will go to that destination. If not, it will follow the rule at
incoming call(Actions).
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Call Back is a function for automatically call back. This feature will check the
CallerID of the customer whether it matched to any rule in the CallerID routing. It will hang
—up the customer call and call the customer back automatically; to reduce customer’s
payment.

To use call back feature, You have to set up CallerIDRouting , Outgoing Call,
Incoming Call, andCall Control.

1. CreateCall Back by go to menuCall Feature>CallBack > Add New Rules
Call Back
[ Call Back Rule ] [ Add Mew Rule ] [ Add Web Call Back ] [ Call Back Properties ]

Add New Rule
Rule Mame test_callb

Description call back testing

Select IVR to Play | business time EI

APPLY | Cancel

Specify the Call Back name and select IVR. Then click APPLY button. The screen
will show as picture below.

Call Back

[ Call Back Rule ] [ Add Mew Rule ] [ Add Web Call Back ] [ Call Back Properties ]
= Rule Name/Web Rule Name Description IVR to Play WEB Web URL Edit

[ test_calb call back testing business time

Re

[ Delete Selected | [ Cancel |

**This Features must be used in combination with the Incoming Call rules or CallerID Routing rules and Outgoing Route on Call Control Page™

2. Create Caller ID Routing to check CallerID from incoming call whether it matched to
the group of Call Back feature by go to menuCall Feature > Caller ID Routing >Add
New Rules

CallerID Routing

[ view Routing Rules ] [ Add Mew Rules ] [ Default Rule ]

Add New Rules
Group lame [test b _[=]*
Rules Name
Destination [ Select [v] Value
Select
MOME (go to next priority)
Group
Extension
VR
Voicemail
Conference
Queue

Custom Application

Fax
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Then go to AddNew Rulesand select function for destination. When theCallerID
matched to the rule, It will transfer that call to the destination. In this case, we, set\the
destination to Call Back feature. Then clickAPPLYbutton. You will get the table
ofCallerIDRouting as picture below.

Rule Name : default é.-?

Group Name : test_cb

Rule Name : pstn_ &
Destination: callback :: test_callb

| DataImport | | CallerlD Routing Export |

No. CallerID Note Edit  Delete
1 10001 &
2 10002 &
3 10003 &
4 10004 &
5 10005 &
& 10006 &
7 10007 &
8 10008 &

[Add New CallerID]

[aPPLy | [ cancel |

From the picture above, we have added CallerID number 10001 to 10008. Whenever
number 10001 — 10008 call to the system. It will hung-up and enter Call back feature.
3. SetupIncomingCallandEnable CallerID-Based Routing Serviceto check the CallerID
and rules. It that caller 1D follow the rule. It will hung-up and call back automatically.
From this example, we enter the call back feature with IVR.
Incoming Call

[ view Incoming Call ] [ Add Mew Incoming Call ]
Add Incoming Call

Trunk [ trunk:dahdi:pstn_test [« | [ pagx-ink
Description
Support DID [no [+]
Replace CallerID
Extensions Ring Timeout{sec) 40 | -
Enable CallerID-Based Routing Service test cb |~
[ Add time based handler |
Actions
|W|'E“ =H| All_Time EI”DESti“"’“"“= [ custom Application E||

|Va|ue aaa aaa |
| Remaove |
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4. SetupOutgoing Call for call out. Egcall to02-xxx-xxxXx or08-xxxx-xxxxfrom Calle
Routingfeature. We can set theOutgoing Call at menu Outgoing call
Outgoing Call

OutGoing Call

[ view Outgoing ] [ Add New Out Going Call ]
Outgoing Route Information

Route Mame ||:|sh'1

Route Description |
Route Password |

Time Based Call Routing

Default Route

Enable Trunk: | ZAP/trunk:dahdi:pstn_test IZI Default Outgoing Mumber: I Dialing Prefix: I Digit to Strip: I
Dialing Option: I

Call Patterns
Call Prefix
Destination Pattern 02,
Destination Pattern 2(optional) IOS—
Destination Pattern 3(optional) |
Dial Timeout |40—
Concurrent Call Limit for this trunk W
Strict Time Routing
Support DID With This Route
5. Set the permission at Call Control to allowOutgoingCallforCallBackas picture below

Call Control

- m

Q| o

Q|2

o m

| g

[= ]
c || @ LS
g |8 | Q|7 Tyl
[T I B = L
B = 2 4= |
S om0 | e W ful]
QO S |+« 40 [
C 2 £ % 2| 2 |-
=== D S| ;W
nmijc - @ o @O QW
b= 2 T - S B ¥ R = A = o
H H E ) e s N
[/ ARVERVE (V] |71 | O] | @] | @1 (@1 [ | &)
VIRl IR O O O &) O O &=
VERVER R & O @ | & & O
O N | | o N O N N T R
O o S o N N Y Y

H N W=
N N W e

We can also use Call Back feature from Web User Interface for enter the phone
number and call back to that number.
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To SetupWeb Call Back, go toWeb Call Back at menuCall Feature > Call Back > Add
Web Call Back. Then specifyWeb Rules Name. The system will create the URLLInk. Y.ou
should select the IVR to use when call back. Then click Apply button.

Call Back

[ Call Back Rule ] [ Add Mew Rule ] [ Add Web Call Back ] [ Call Back Properties ]
Add web Call Back

Web Rules Name web_call_b
Web URL http:/f192. 168.0. 126/m@lbadweb_call_b.php
Select IVR to Play | business time EI

Enable CAPTCHA u

[ APPLY | | Cancel |

From this example, We get URL Link
‘http://192.168.0.126/callback/web_call_b.phpWe can go to this page and enter our phone
number for automatic call back.

PLEXTEL
SUERYEESEETECETEM
Enter your Number 021234567
Close
Call Back Solutions Powered by PLEXTEL SYSTEM

10.3 External Database Connector

Go to menu Call Features >> External Database Connectorand choose New Connector
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http://192.168.0.126/callback/web_call_b.php

External Database Connector
[ List Connectar ] [ Mew Connector ]

New Connector
Connector Mame

Description

Database Type | Mysqgl |Z|

Server IP Address
Username

Password

APPLY

Connector Name : Specify name

Description : Specify the description

Database Type : Select database type

Server IP Address : Specify IP-Address of database server (or you can fill ‘localhost’ to
connect internal database)

Username :Specify username of the databaseserver

Password : Specify password of the database server
Then click apply button.

There 2 types to query database

1. Automatic SQL Query

Database Name : Choose database

Table Name : Choose database

Request Field Name : Choose field name

Compare Field Name : Choose field to compare

Request Value : Input the test value (for testing)
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Automatic SQL Query
HOST : localhost

Database Mame:

Table Mame:

Reguest Field Name:

Compare Field Mame:

Reguest Yalue:

test
ch_db

ID_Card

ID_Card

=]
=]
=]

[=]

AND

| TEST | | Clear |

After select database, table and field, you can test by input the data into Request Value and

pressTEST button. The system will bring those Request Valueto compare with field name and

return the rquest field nameto show on the screne.

2. Manual SQL Query Command - Input SQL query string by yourself.

Manual 5QL Query Command

Request Value 1
Request Value 2

Reguest Value 3

HCMP 1%
YCMP 2%

YCMP 3%
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Chapter11: Help

?

You can take a quick look for key feature code at Help menu " on the top right of the

Features Code

‘Call Center Code

Agent Login (permanent) : [~ ) ,\"“9

Agent Callback Automatic LoginTogoff - A =
= ginlLog ( #)(wa)5)
cLogin:  E\ (O AVC @)

Agent CallBack Login: (g '(.....4 (..0)

< - Y s T
Agent CallBack Logoff: [~ H '(n--d)\__‘l)

Pause Agent Prefix : m“ 4

\nc

UnPause Agent Prefix : ,/7#\, '(1;4 ] l\" M;S )
Transfer to Agent Prefix - I(m« 4) (m“ 4)

Whisper: (o %) (we9) (am?)

- - - TN e By
Private Whisper: | s ¥ (weva 9;' (_ruv le
T e O W
Channel 8552 (%) (a9 (@)

‘Call Parking
Parking Number : C’““?} . /_ . /,

Pasking Position: (TN (L.0) (1) _(wu?) G2 (.0)

Max Parking Time - 0
e anlenleEn)

Transfer digit imeout : l\" e 3 )

Features Key Mapping

it ti : Is '
Feamres digit timeout{ms) : l\nu 3 . oj . oj . 0)

; . T
CZJJ Plck_up - r --‘-A I\_NI'I' 8_‘,'

Extensions Pickup: (3 ( 3¢
aen ) (aon )

Blind Transfer : BT

Artend Transfer © |’\Mlc )

Disconnect © BT 1
C #)0(_.0)

- T
One Touch Record: (7 g |\’ e 3)

| - - oA =
Voicemail - \__1) .'/__0). '{._0/'

Phenelock: (O g'( . .9
\mer D ) e ™

Roaming Station Register / Dial-Out Prefix :

Y T ] T

FaxPrefix: (%) (our 3)
screen o
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